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Introduction
The Windows Home Accountant program allows you to keep track of your household 

expenses, incomes, bank accounts, and credit cards.By defining the proper 
information to Home Accountant, you can determine exactly how your money is 
being spent.    In addition to helping you track where your money is being spent, 
Home Accountant provides useful financial analysis tools:

o A report feature that allows you to generate several types of spending reports,
including bar charts and pie charts.

o A 'double-click' zoom, which allows you t instantly create a detailed report 
from an overview report.

You define three types of financial data to Home Accountant: Accounts, Transactions, 
and Categories.    

o Accounts represent either bank accounts, cash, or credit cards.    

o Transactions define a movement of funds into or out of accounts.    There are 3
different kinds of transactions: 
- a transfer is a movement from one account to another; 
- an expense is a payment made from an account; 
- an income is a deposit into an account from an external source, such as a 

salary.    

o Categories are a way of classifying transactions.    Categories fall into two 
general types: 
- Expense categories.    Expense categories are used to categorize expense 

transactions.    Examples of expense categories are Mortage Payments 
or Automotive Expenses;

- Income categories, which represent sources of income.    An example of an
income category might be Bill's Salary.

Defining Your Financial Data
Expense and income transactions must define both an account and a category.    Expense 

transactions name an account from which the expense is being paid and an expense 
category.    Income transactions define an account into which the deposit is made and
an income category.    Transfer transactions define two accounts: the 'from' account, 
where funds are withdrawn from; and the 'to' account, where funds are deposited 
into.    An example of a Transfer transaction might be the payment of a credit card bill,
where money is transferred from a bank account into a credit card account.

You can define a special type of Category called a Major Category, which is used to group 
together other categories for reporting purposes.    For example, suppose you have 
two family cars, and you want to keep track of the expenses separately.    You define a
simple category for each car's expenses.    However, at times, you want a convenient 
way of looking at both categories together.    You can define a major category called 
Automotive Expenses, and associate both automotive categories with the new major 
category.    Now you can create reports or charts for the major category, which will 
include information from all sub-categories.    

Budget Files
Home Accountant normally retains detailed information on accounts, categories, and 



transactions in a file called a Budget file.    Budget files are loaded and saved to and 
from disk using the File pull-down menu.    You can keep a complete history of all 
your transactions in your Budget file; however, to save space, Home Accountant 
includes a Consolidation function which allows you to combine older transactions by 
month, category, and optionally by account.    This saves space in the Budget file at 
the expense of some loss of detail.

Printing Checks
You can specify that you want Home Accountant to automatically print checks for you 

when you define transactions involving a Bank Account.    It is necessary for you to 
define the characteristics of your checks when you define your Bank Account in order
to enable the printing of checks.

Memorizing Transactions
A handy feature of Home Accountant is the ability to memorize commonly-entered 

transaction and recall them at a later time.    For example, monthly payment of the 
rent or mortgage could be a memorized transaction.    You store a model for the 
transaction within the budget file.    When you want to use the model as a live 
transaction, use the recall function to bring the model to the screen for entry as a 
real transaction.    The model transaction can contain all transaction detail with the 
exception of date and time, which are automatically updated with the current date 
and time when the transaction is recalled.

Defining Future Transactions
Home Accountant also allows you to create transactions that will not be made until 

some time in the future.    When the defined future date occurs, Home Accountant 
allows you to view and possibly alter the transaction definition prior to it's entry as a 
real transaction.    Future transactions can be defined as re-occurring: they will 
continued to be re-scheduled on a regular basis (daily, weekly, or monthly).

Generating Financial Reports
Five different reports can be generated by Home Accountant: an Account Status report, 

a Transaction report, a Trends Report., an Account History, and a Budget Variance 
report.    Two different kinds of charts can be easily created: a bar chart,which 
provides a history of one or more categories over time, and a pie chart,which breaks 
down the distribution of expenses or incomes by category. All reports and charts can 
be viewed on the screen or sent to your printer via the Print option.

Report definitions can be created and saved along with your Budget file.    You can 
customize the information you want to appear on the report, and save the resulting 
report definition.    Saved report definitions can be used at any time to recreate the 
report.



Account
Something from which payments can be made, and income can be deposited into.    There

are three types of accounts: Bank Accounts, Credit Cards, and Cash.



Transaction
An exchange of funds.    There are three types of transactions: Expense (a payment for 

something from an account); Income (a deposit into an account from an external 
source, such as a salary); and Transfer (a movement of funds from one account to 
another).



Category
A means of classifying either Expense or Income Transactions.    There are two general 

types of categories: Expense and Income.



Major Category
A means of grouping other, related Categories together for reporting purposes.    When 

you define a major category, you associate one or more other categories with it.    
When you display the major category, information associated with the sub-ordinant 
categories is shown.



What's New in Version 3.3
The following features/changes have been made to Version 3.25 of Home Accountant 

for Windows:

o Account and Category Container Windows are now supported.    These 
windows display the Icons for each Account and Category you have associated
with them.    You can manipulate and define accounts and categories directly 
from these windows, and you can create transactions by dragging one icon to 
another.

o You can now define an Auto Refresh interval which will cause Home 
Accountant to automatically update all your report windows with new data 
on a periodic interval.

o When accounts and categories are displayed in a drop-down list within a 
dialog box, you can key in a character, and Home Accountant will scroll the 
drop-down list to the first account or category beginning with the character.

o The Printer Setup... option within the File menu now displays the Windows 
standard printer setup dialog box..

o Category Icons are now displayed on the Trends report.

o You can now reconcile Credit Card transactions, as well as transactions 
involving Bank Accounts.    See the topic Transaction Reconcilliation for 
further details.

o Various bugs have been fixed.



What's New in Version 3.2
The following features/changes have been made to Version 3.2 of Home Accountant for

Windows:

o When transactions are displayed in a Select Transaction Dialog Box, they 
are now displayed in reverse chronological order (from most recent to oldest). 
These transactions are displayed with an Icon representing the category 
associated with the transaction.    Only the most recent 500 transactions are 
displayed.

o If future transactions are defined, then the Icons representing the transactions
are displayed in the calendar on the days in which the future transactions are 
scheduled to occur.

o If you select or double-click a day on the calendar for which future 
transactions are defined, the Future Transactions report is displayed.

o If you select or double-click on a date in the past within the Calendar window, 
the resulting report now shows all transactions entered on the that day, not 
just the expenses.

o A facility now exists for Archiving old transactions to another budget file.    See
the topic The Archive Option for further details.

o An option in the Create Transaction Trends Bar Graph allows you to easily 
define a Total Expenses vs. Total Income bar graph.    See the topic Defining 
the Trends Graph for more details.

o It's now possible to 'un-associate' an Icon from a Category.

o The Check Reconciliation Dialog Box now displays the sum amount of each 
unreconciled transaction.

o A problem in the handling of duplicate transactions has been fixed.    It is now 
possible to select either one of two duplicately defined transactions; in prior 
releases, only the first could be selected.



What's New in Version 3.1
The following features/changes have been made to Version 3.1 of Home Accountant for

Windows:

o You now have your choice of Toolbar formats: either small (featuring 15 small 
buttons at the top of the Main Window under the menu); large (featuring 8 
larger buttons at the top of the Main Window); or floating (a moveable 
window which contains 15 small buttons).    An option is available for 
customizing the contents of the large toolbar.    See the description of the 
Toolbar options for further details 

o A new report, the Budget Variance is now available. .This report will show 
the relationship between monthly expenses and budget for your expense 
Categories.

o The Define Simple Category and Define Major Category Dialog Boxes 
now contain a graph indicating how close you are to exceeding the monthly 
budget for the category.

o Improvements have been made to vertical scrolling within report sub-
windows.    As you scroll through a report vertically, only the report details 
change; the report and column heading remain locked on the screen.

o 3 new options on the Help pull-down menu are now available:
o Search for Topic brings up the Windows Help Search Dialog Box, 

allowing you to search for a specific keyword within the Help information.
o Current Report will provide Help information specific to the type of 

report currently displayed on the screen.    If more than one report 
appears on the screen, Current Report will provide information on the 
topmost window.

o Using Help provides information on the use of Help itself.

o Additional Help information has been provided specific to reading and 
understanding the contents of the reports that can be produced by Home 
Accountant.    This information can be obtained by selecting the Current 
Report option under the Help pull-down menu.



What's New in Version 3.0
The following features/changes have been made to Version 3.0 of Home Accountant for

Windows:

o You can now import transactions to Home Accountant from other sources, 
such as the Windows Clipboard, ASCII Text files, and Quicken.

o Home Accountant will now automatically add interest to your interest-
bearing bank accounts.    See the description of the Define Account   Dialog   
Box for details.

o A Mortage Calculator has been implemented.    The Mortage Calculator will 
compute the payment amount for any standard amortized loan.

o If you print a Bar Chart or Pie Chart, the legend will now be printed, if the 
legend appears on the screen.

o Most dialog boxes now have context-sensitive field-level help.    If you press 
PF1 while the Dialog Box is displayed, a popup window appears providing help 
for just the field that has the current input focus.    You can still get help 
information on the entire Dialog Box by clicking the Help button.

o The To field on the Define Transaction   Dialog Box   is now a Drop-Down box 
in which any of the previous 20 To field values can be selected. 

o A problem with excessive use of System Resources has been fixed.



What's New in Version 2.9
The following features/changes have been made to Version 2.9 of Home Accountant for

Windows:

o Home Accountant will now print checks for you when you define a 
transaction involving a Bank Account.    For more details, see topic Automatic
Printing of Checks.

o You can now define your own Icons and associate these icons with your 
Categories.    See topic Using Your Own Category Icons for more details.



Creating a New Budget File
Use the New option of the File menu to create a new Budget file.    This function clears all

Account, Category, and Transaction entries and allows you to start a new Budget.    If 
you are working with another budget file when you select this function, and you have 
made changes to it since you last saved it, you will be prompted to save it.



Opening a Budget File
Use the Open option of the File menu to open and load an existing Budget file.    You are 

then prompted with a Dialog Box for the file name.    Note that Budget files by 
convention end with the .BGT suffix on the file name.    Whenever you open a Budget 
file, the Account Balance report is displayed on the screen automatically.

As the Budget file is being loaded, the File Load Progress Dialog Box lets you know how
far along the operation is.    If you wish to cancel the Open operation, click the Cancel
button.

You can also open a Budget file by 'Dragging' it to Home Accountant from the Windows 
File Manager.



Saving a Budget File
Use the Save option of the File menu to save your updated Budget file.    This option 

writes the current contents of the budget file back to the Disk under the name shown 
in the Window title.    If there is no name in the title, you will be prompted for a file 
name.

As the Budget file is being saved, the File Save Progress Dialog Box lets you know how 
far along the operation is.    If you wish to cancel the save, click the Cancel button.



Saving a Budget File under a Different 
Name

If you have made changes to your budget file, but wish to rename the Budget file when 
you save it, use the Save As option from the File menu.    You are prompted with a 
Dialog Box to enter a name for the new file.    Note that Budget files by convention 
end with the .BGT suffix on the file name.

As the budget file is being saved, the File Save Progress Dialog Box lets you know how 
far along the operation is.    If you wish to cancel the save, click the Cancel button.



Using your own Category Icons
Home Accountant comes with a set of pre-defined Icons which you can associate with 

your expense or income categories on the Define Category   Dialog Box  .

If you have your own ICON files (suffixed with "*.ICO") and wish to use them in addition to
the pre-defined category icons, you can define them to Home Accountant by 
selecting the Add Icons... option on the File pull-down menu.    A Dialog Box is 
displayed which allows you to select which ICON file you want to be made available.   
Once you have chosen an ICON file, the icon contained within will be made available 
to you on the Define Category   Dialog Box  .

Note that it is the name of the ICON file, not the icon 
itself, which is permanently associated with your budget 
file.    The actual icon is reloaded from the ICON file each 
time the budget file is OPENed.    What this means is that
if you later delete the ICON file, the icon will no longer 
be available to any category to which it is associated.



Deleting User-Defined Icons
Use the Delete User Icons... option from the File pull-down menu    in order to delete 

references to a User-Defined Category Icon from the Budget file.    You can define new
Icon files for use with the Add Icons.. option.    If you later decide that you no longer 
want to use one of these Icons, the Icons can be deleted with the Delete User 
Icons... option.

When you select this option, the Select Icon File to Delete Dialog Box is displayed.    
Select an Icon file in the List box and click the Delete button to remove references to
the Icon from the Budget File.    Click the Done button when you are finished.

Note that when you Delete an Icon with this Dialog Box, 
you are not actually deleting the Icon file.    You are 
merely removing any references to the Icon from your 
budget file.    Any categories which are associated with a 
deleted Icon are modified so that they are no longer 
associated with any Icon.



Exporting Transactions to an External File
Use the Export option from the File menu to save a group of transactions (based upon 

date) to an external file.    This option is useful for maintaining a single budget from 
multiple systems.    One of the systems should contain the master copy of the budget 
file, while the other system(s) contain secondary copies.    You can enter transactions 
on one of the secondary copies, then periodically export the transactions to an export
file.    This export file can then be imported into the master system to bring it up to 
date.

When you select the Export option, you will be prompted with two dialog boxes.    The 
first is used to prompt you with a date range for selecting transactions to be 
exported.    You must enter a To date which provides an end limit for the selection; 
the From date is optional, and provides a beginning limit for the transaction.    If no 
From date is provided, then all transactions entered up to and including the To date 
are exported; if you enter a From date, then transactions on or after this date, up to 
and including the To date, are exported.

The second dialog box is a file selection box which allows you to specify the name and 
location for the export file.    Note that by convention, export files have the suffix 
BEX.



Importing Transactions from an External 
File

Home Accountant allows you to import transactions from other systems or formats by 
using the Import option under the File menu.    Transactions can be imported from 4 
different sources:

o        From other   Home Accountant   systems  
o        From the Windows Clipboard  
o        From a ASCII File  
o        From a   Quicken Interchange Format   (QIF) file  



The Archive Function
The Archive option, located under the File menu, is used to create a new budget file 

from your existing file by removing from it activity which took place prior to a specific
date.    The new budget file is referred to as an archive file.    It contains all accounts 
and categories that are defined in your current budget file, but contains only those 
transactions whose dates occur on or earlier that the date you specify on the 
Transaction Archive screen.    All of the transactions which are moved to the archive
file are deleted from the current budget file; thus, this option provides a means of 
cleaning up your budget file by purging it of old activity, but at the same, retaining a 
record of the purged activity.

For example, let's say you specify 12/31/93 as the date on the Transaction Archive 
screen.    All transactions created on or before 12/31/93 will be removed from the 
existing budget file and included in the Archived file.

The output from the Archive process is a budget file, which itself can be loaded and 
examined by Home Accountant.    However, as the activity within this file represents
old, inactive transactions, the information in the Archived budget file should not be 
altered by Home Accountant.    Note that within the archived budget file, Home 
Accountant will attempt to restore the balances of each Account to the values they 
had at the end of the interval.

When you enter the Archive option, the Transaction Archive Dialog Box is displayed.    
This Dialog Box allows you to enter the Date, prior to which all transactions will be 
archived.    The Dialog Box also allows you to define the name and subdirectory of 
your Archived budget file.    When you click the OK button, the Archive file is created.



The Print Function
The Print option, located under the File menu, is used to send the report being shown on

the screen to your current default printer.    You can use the Printer Setup option to 
check to see which is your current default printer prior to executing this function.

 



The Printer Setup Function
If you need to send a report to your printer, the Printer Setup option of the File menu 

can be used to specify setup parameters for the printer.    When you enter this option,
you are prompted with the Default Printer Select Dialog Box.    You can choose to 
setup either the current default printer, (by leaving the Default Printer button 
selected) or any of your other defined printers (by selecting Specific Printer).    You 
can choose the print orientation for the printer (either Portrait or Landscape), and the
paper size and source.    Select the Setup... button to bring up the Options Dialog 
Box, allowing you to specify options which are specific to the particular printer.

When you are done setting the options for your printer, click the OK button.    Select the 
Cancel button to exit the Dialog without modifying the printer setup.



Changing the Font for Reports
Use the Fonts sub-menu from the File menu to change the font (character style) used to 

create a report.    When you select this option, the Font dialog box is selected.    This 
dialog box allows you to select a new default typeface and character size for the 
current report sub-window.    It also establishes a default font for any new report 
windows you create.    Note that fonts sizes are measured in points.



Exiting Home Accountant
Use the Exit option of the File menu to exit the Home Accountant.    If you have made 

unsaved changes to your Budget file, you are prompted with a Dialog Box asking if 
you want to save the file.



OPENing Previously Accessed Files
Under the Exit entry in the File menu, you may find up to 4 additional entries.    Each of 

these entries is a Budget File which you have previously accessed with Home 
Accountant.    By selecting one of these entries, you will cause the file to be OPENed.



Registration
Registration for Home Accountant for Windows is only $15 ($20 outside North 

America, to cover extra postage).    If you register , you will receive a Hardcopy User's
Guide, plus you will be entitled to Technical Support from the author, including free 
upgrades.    

There are two ways to register for Home Accountant:

o If you have a membership on CompuServe, you can use the CompuServe 
Shareware Registration Process.    The author's CompuServe ID is 71672,3344.

o You can print the User Registration Form below and mail it, along with a check 
or money order, directly to the author at the following address:
Brad Winslow
1205 Beryl St. Apt. C
Redondo Beach, CA 90277 
USA
Be sure to provide your return address, and indicate what version of Home 
Accountant you currently have.    You will receive a hardcopy User's Guide, 
and the latest version of the software.

You can contact the author on the Internet using the following address: 
BWINS@ix.netcom.com

You can contact the author through America Online using the Screen Name BradWin

Click on the word Print to send the contents of this topic (along with the Registration    
form) to your printer.





Importing Transactions from Home 
Accountant

Use the Import from Home Accountant... option under the File menu to cause a 
group of Transactions, exported from another system using the export option, to be 
read in and applied against your current budget.    This option is useful for 
maintaining a single budget from multiple systems.    One of the systems should 
contain the master copy of the budget file, while the other system(s) contain 
secondary copies.    You can enter transactions on one of the secondary copies, then 
periodically export the transactions to an export file.    This export file can then be 
imported into the master system to bring it up to date.

When you select the Import from Home Accountant...option, you will be prompted 
with a file selection dialog box, used for specifying the name of the export file to be 
read.        Note that by convention, export files have the suffix BEX.    When you select 
a file, the transactions in the file are read and processed by Home Accountant as if 
they had been entered manually.    Home Accountant checks for duplications, and 
will not process a transaction that has the same Description for the same date as an 
existing transaction.    If Home Accountant detects a duplicate transaction, it will 
prompt you with a dialog box, asking you if you want to edit the transaction.    If you 
select YES, then the Edit Transaction Dialog Box is displayed, allowing you to edit the
transaction.    

You can also import an export file by 'Dragging' it to Home Accountant from the 
Windows File Manager.

Note that for the Import and Export features to be 
effective, the secondary copies of the budget file must 
contain the exact same Account and Category definitions
as the Master copy.    If you export a transaction that 
refers to an Account or Category that is not defined on 
the importing system, then the transaction will not be 
completely processed on the importing system.    The 
easiest way to keep the Master and Secondary copies in 
sync is to periodically copy the entire budget file from 
the Master to the secondary systems.



Importing Transactions from the Windows 
Clipboard

If you want to import transactions that are stored in another Windows application (such as
Microsoft Excel), you can cut or copy the transactions to the Windows clipboard and 
use the Import From Clipboard option under the File menu to bring the 
transactions into Home Accountant.    In order for this option to work, the 
transactions must be in the format required by Home Accountant:

o The data must be in tabular format;
o The first row in the table must contain the column headings. The following 

column headings can be specified:
- Description (required)
- Type (required)
- To (required)
- Date (required)
- Account (required)
- Category (required)
- Amount (required)
- Time (optional)
- Check Number (optional)
The columns can be specified in any order, as long as each of the required 
columns is present

o Each subsequent row of the table defines a new transaction.    The columns of 
the table contain the data for transaction, as defined by column headings.    
The Type column should contain either Expense, Income, or Transfer.

For example, the following set of cells from Microsoft Excel could be copied to the 
clipboard, and imported into Home Accountant as two new transactions:

If the Account or Category referenced by an imported transaction does not exist, Home 
Accountant prompts you and allows you the option of creating it dynamically.



Importing Transactions from an ASCII File
You can import transactions from an ASCII (Text) file, provided that the transactions are 

stored in the proper format.    The following is the format required by Home 
Accountant for Text files:

o The data must be in tabular format;
o The rows of the table are separated by CarriageReturn-LineFeed sequences;
o The columns within each row are separated by commas, or by Tab characters;
o The first row in the table must contain the column headings. The following 

column headings can be specified:
- Description (required)
- Type (required)
- To (required)
- Date (required)
- Account (required)
- Category (required)
- Time (optional)
- Check Number (optional)
The columns can be specified in any order, as long as each of the required 
columns is present

o Each subsequent row of the table defines a new transaction.    The columns of 
the table contain the data for transaction, as defined by column headings.    
The Type column should contain either Expense, Income, or Transfer.

For example, if a text file contains the following data, it can be imported into Home 
Accountant as two new transactions:

Description, Type, To, Date, Amount, Account, Category<CR><LF>
Bought Gas, Expense, Shell Auto, 6/30/94, 10.00, Gas Credit Card, Automotive<CR><LF>
Lunch, Expense, McDonald's, 7/1/94, 5.50, Cash, Dining<CR><LF>

Note that in the example above, '<CR><LF>' represents 
a CarriageReturn - LineFeed sequence.

If the Account or Category referenced by an imported transaction does not exist, Home 
Accountant prompts you and allows you the option of creating it dynamically.

If you select the Import from ASCII File... option, the Select File to Import Dialog Box
is displayed which allows you to specify the name of the import file.



Importing Transactions from a Quicken 
Interchange Format (QIF) File

If you are a current user of the Quicken program, you can import your transactions to 
Home Accountant by using the Quicken Interchange Format, or QIF.    Using 
Quicken, select the Export... option under the File pull-down menu.    Select the 
Account to export from, the data range, and the name of the QIF file to create.    The 
Transactions box should be checked. You can also check the Accounts List, 
Category List, and Memorized Transactions;    however, only the information 
pertaining to the selected Account will be used by Home Accountant.

Next, select the Import from Quicken... option from the File pull-down menu in Home 
Accountant.    The Import from Quicken Interchange Format File Dialog Box will
appear, allowing you to select the QIF to import from.    If you did not specify the 
Accounts List option when you created the QIF file, or if you wish to override the 
specification of the Account associated with the transactions, select the account with 
the Import To Account list box.

You must repeat this procedure for each Quicken account which contains transactions you
wish to import.

If the Account or Category referenced by an imported transaction does not exist, Home 
Accountant prompts you and allows you the option of creating it dynamically.





Viewing Reports on the Display Screen
When you use the Home Accountant program to generate a report to the display, the 

report appears within a report sub-window within the Home Accountant client area. 
Each time you create a new report, a new report window is created.    Each report 
window can be controlled individually, and is totally independent from the other 
report windows.    The following shows a Home Accountant screen with two report 
sub-windows:

This screen contains two windows, each containing a Home Accountant report.    Only 
one of these reports can be active at a time.    You can activate a report window by 
clicking on it with the mouse, or by selecting the report name from the Window 
option.    When a report is active, the Home Accountant menu bar reflects the 
options appropriate for that report type.

Scrolling Through a Report
If a report is to large to fit in a window, Horizontal and/or Vertical Scroll bars appear to 

allow you to scroll within the report.    You can use your mouse to control the scroll 
bars and scroll through the report in the usual manner.    In addition, you can use the 
following keyboard interface to scroll a report:

o Use the up arrow and down arrow keys to scroll through the report one line 
at a time.

o Use the Page Up and Page Down keys to scroll through the report one page 
at a time.

o Use the Home key to scroll immediately to the beginning of the report.
o Use the End key to scroll immediately to the end of the report.
o Use the Tab key to 'highlight' the next item on the screen, so that it can be 

selected for zooming.
o Use the Escape key to remove highlighting from the current entry.
o Use the Enter key to 'zoom' in on the current highlighted entry.    See the 



description of zooming below.
o If you hold down the Shift key and press the Enter key, the Font Dialog Box 

appears.    This allows you to modify the font associated with the current 
highlighted entry.

As you scroll through a report, the report heading retains it's original position within the 
window; only report details are scrolled.

Obtaining Details About a Report Item
If you see an item on a report for which you wish to see more details, you can 'zoom-in' 

on the item in question.    You select an item for zooming by either clicking on it with 
the mouse, or by pressing the Tab key until the entry is highlighted.    Zoom in on the 
selected item by double clicking on it with the left mouse button or by pressing the 
Enter  key.    As a    result of zooming-in on a report item,    a new report sub-window 
or Dialog Box is created, containing more details about the selected item.    For 
example, if you zoom in on a Category or Account name in a Transaction Summary 
report, a Transaction detail report for the selected item for the same date range is 
displayed in a new window.    If you are displaying a Transaction Detail report, and you
zoom in on a particular entry, the Define Transaction Dialog Box for the selected 
transaction is then displayed.    If you zoom in on a dollar value on the Trends report, 
a Transaction Detail report for the corresponding month and Expense Category is 
displayed.

Changing the Report Style
You can change the font (character style) of any element within a report by either 

selecting the element (by using the Tab key or by clicking on it with either mouse 
button), and then either double-clicking on it with the right mouse button or holding 
down the Shift key while pressing the Enter key.    When either of these actions are 
performed, the Font Dialog Box is displayed.    This Dialog Box allows you to select a 
new font for the display of the selected text.

You can access the System Menu for the report window by clicking on the  at the upper
left hand corner of the sub-window.    Several useful options are available on the 
System menu; the following topics describe those options that are unique to Home 
Accountant.

Deleting a Report Window
You can get rid of a Report Window by selecting the Close option from the System menu 

for the sub-window.



Accessing the System Menu
When you access the System Menu for a report sub-window by clicking on the , a pull-

down menu is displayed which contains several useful options.    Four of these options
are unique for Home Accountant, and are described in the following topics:

o Title, which allows you to change the title of a report sub-window;
o Refresh, which causes the current report to be re-created with more current 

data;
o Memorize, which causes the report definition that created the current report to

be saved as a Memorize report;
o Recreate, which allows you to respecify the parameters that created the 

current report and to regenerate the report.



Changing the Window Title
Use the Title option from a report sub-window System Menu to change the title 

associated with the sub-window.    When this option is selected, a Dialog Box is 
displayed, showing the current window title, and allowing you to change it.    If you 
decide you want to change the title, key in the new title, and click on the OK button.   
If you change your mind and decide not you change the title, click the Cancel button.



Refreshing the Report
Normally, when you define a report, the contents of the report are not updated to reflect 

any changes that you make to the data.    For example, if you create a Transaction 
detail report, then define a new transaction, the new transaction will not show up in 
the report.

The Refresh option on the report sub-window System menu option causes the report to 
be refreshed with the most current data defined to Home Accountant.    It is as if the
report was redefined and recreated from scratch.

If you enable the Auto Refresh option, Home Accountant will automatically refresh 
each report window on a periodic basis.

If you want to refresh the report using a different set of report definition parameters, you 
must use the Recreate option.



Memorizing the Report Definition
Use the Memorize option, located within the report sub-window's System pop-up menu, 

to cause the report definition that created the report to be saved.    The information 
that you entered on the Dialog Box which created this report is saved with the Budget
file.    This report definition information can be reused to reproduce this report in the 
future by using the Recall option under the Reports pull-down menu.    This allows 
you to create customized reports and recall them at any time.

Note that the current sub-window title is used to 
uniquely identify this report definition.    Therefore, it is 
a requirement that any report definition you memorize 
must have a different window title than any previously 
saved report definition titles.



Redefining the Report
Use the Recreate option under the report sub-window's System menu to redefine the 

original report definition and recreate the report with the modified definition.    When 
this option is selected, the original Dialog Box used to set up the report is displayed.   
You can then modify the report definition by entering the changed information into 
the Dialog Box.    When you click OK, the report is regenerated with the new 
definition.    If you click Cancel on the report definition Dialog Box, the original report 
remains in the report sub-window.



Defining the Transaction Report
The Transactions option, located under the Reports menu, allows you to see or print a 

report of your transactions.    When you select this option, the Select Report 
Characteristics Dialog Box is displayed:

When you select the OK button, the Transaction Report you defined is displayed in a new 
Report Sub-window.

See the topic Understanding the Transaction Report for information about the 
contents of the Transaction Report



Report Title
Enter the title that you want to appear at the top of the report.    This is also used to title 

the Report Sub-window, and it used to uniquely identify the report if you Memorize 
it.



Start Date
Enter the date in standard format.    Only transactions occurring on or after the start date 

are included in the report.



End Date
Enter the date in standard format.    Only transactions occurring on or before the end date

are included in the report.



Show Detail Box
Check this box to see detailed information for the transactions.    If this flag is not set, you 

will only see transaction summaries by category or by account.



Report By
This area indicates whether you want to see transactions broken out by Category or by 

Account. 



Show Expenses or Income
These buttons indicate whether you want to see Expense Transactions or Income 

Transactions.    Only one of them can be checked.



Select Category (or Account)
The Select drop-down list allows you specify a Category (if you choose the Report by 

Category option) or Account (if you choose Report by Account).    If you do not 
select an entry in this box, a report is produced showing transactions for each simple 
Category or Account.

If you type a character on your keyboard, Home Accountant will automatically scroll this
list box to the first category or account beginning with the character.



Output To
These buttons allow you choose whether you want the report to be written to the Screen 

or to the Printer.    



Select Printer
This list box only appears if the Printer box is selected in the Output To area.    This list 

allows you to select a target printer for your output.



OK Button
When you fill in the parameters that define your Transaction report, press the OK button 

and the report will be shown in a new report window, or will be sent to the printer.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



Defining the Account Balance Report
Select the Accounts option, located under the Reports menu, to report the current 

status of each of your defined accounts. 

See the topic Understanding the Account Balance Report to find out more about the 
contents of the Account Balance Report

Note that you can only have one Account Balance Report window defined at any one 
time.    If you select this option when an Account Report window already exists, then 
the existing Account Report is refreshed.



Defining the Trends Report
The Trends option, located under the Reports menu, is selected to display the Expense 

Category Trends Report.    This report shows you how much you have spent in the 
selected expense categories by month.    It can also show the budget values 
associated with the selected categories, and indicate the amount over or under 
budget for each month.    The report also shows total expenses and total income.    

When you select this option, the Create Expense Trends Report Dialog Box appears on
the screen:

When you select the OK Button, a new Trends Report is created.    See the topic 
Understanding the Trends Report to learn more about the contents of the Trends 
Report.



Report Title
Enter the title that you want to appear at the top of the report.    This is also used to title 

the Report Sub-window, and it used to uniquely identify the report if you Memorize 
it.



Start Date
Enter the month range as the Start Month and End Month in MM/YY format. 



End Date
Enter the month range as the Start Month and End Month in MM/YY format. 



Show Over/Under Budget
If the Show Over/Under Budget option is selected, the amount over/under budget 

appears underneath each category's expenses for the month.    If you were over 
budget for the month (spent too much), the amount appears in red (if you have a 
color monitor). 



Select Categories
You can select which categories you want to see in the Select Categories List Box.    By 

default, all categories are selected. 



OK Button
Click the OK button to display the report in a new report window.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



All Button
The All button offers you a convienent means of selecting each Category within the 

Select Categories List Box.



None Button
Select this button to de-select each entry in the Select Categories List Box



Defining the Account History Report
The Account History option within the Reports menu allows you to generate a report 

which shows all the transaction activity against an Account for a specified period of 
time.    The first line of the report shows the Account's Balance at the start of the 
interval.    Each subsequent report line represents a transaction involving the account.
You can track how the balance within the account changed over the course of the 
selected time period.

When you first select the Account History option, the following dialog box is displayed:

When you select the OK Button, a new Account History Report is created.    See the topic 
Understanding the Account History to learn more about the contents of the 
Account History Report.



Report Title
Enter the title that you want to appear at the top of the report.    This is also used to title 

the Report Sub-window, and it used to uniquely identify the report if you Memorize 
it.



Start Date
Enter the date for the start of the report, in standard format.    Transactions occurring on 

or after this date are included in the report. 



End Date
Enter the date for the end of the report, in standard format.    Transactions occurring on or

prior this date are included in the report. 



Select Account
 This box allows you to select the account for which the report is to be created.    



OK Button
Click the OK button to display the report in a new report window.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



Defining the Budget Variance Report
The Budget Variance option, located under the Reports menu, is used to define the 

Budget Variance Report, which shows you how your monthly expenses compare to 
your monthly category budgets.

When you select this option, the Create Budget Variance Report Dialog Box appears 
on the screen:

When you select the OK Button, a new Budget Variance Report is created.    See the topic 
Understanding the Budget Variance to learn more about the contents of the 
Budget Variance Report.



Report Title
Enter the title that you want to appear at the top of the report.    This is also used to title 

the Report Sub-window, and it used to uniquely identify the report if you Memorize 
it.



Start Date
Enter the month range as the Start Month and End Month in MM/YY format. 



End Date
Enter the month range as the Start Month and End Month in MM/YY format. 



Select Categories
You can select which categories you want to see in the Select Categories List Box.    

Only those expense categories for which you have defined a monthly budget appear 
in this List Box. 



OK Button
Click the OK button to display the report in a new report window.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



All Button
The All button offers you a convienent means of selecting each Category within the 

Select Categories List Box.



None Button
Select this button to de-select each entry in the Select Categories List Box



Start Date Increment Button
Use this button to increment the start month one month at a time.



Start Date Decrement Button
Use this button to decrement the start month one month at a time.



End Date Increment Button
Use this button to increment the end month one month at a time.



End Date Increment Button
Use this button to decrement the end month one month at a time.



Defining the Trends Graph
The Trends Graph option, which is located under the Reports menu, is used to create a 

month-by-month bar graph of the total expenses in one or more categories.    When 
you select this options, a Dialog Box is displayed, which allows you to set control 
parameters for the Bar Graph:

When you click on OK, a new window is created which contains the bar graph.    For more 
information about the Trends Graph, see the topic Understanding the Trends 
Graph.



Report Title
Enter the title that you want to appear at the top of the graph in the Set Graph Title 

field.    This is also used to title the Report Sub-window, and it used to uniquely 
identify the report if you Memorize it.



Graph By Option
The Graph by: option allows you to select either Expense categories or Income 

categories.



Graph Total
The Graph Total checkbox    allows you to generate a graph consisting of a single bar for 

each month.    Each bar represents the sum of all expense or income activity for that 
month.



Draw Budget Reference Line
If you select the Draw Budget Reference Line option, then a horizontal line is drawn 

across the chart for each selected expense category.    The horizontal line(s) represent
the defined Budget values for each selected category.    This option does not appear if
the Graph Total option is selected, or if you are graphing Income categories.



Select Category
The Select {Expense | Income} Category list box allows you to select one or more 

categories for the graph.    This list box disappears if the Graph Total box is checked.



Start Month
The Start Month and End Month fields allow you to specify the time period to appear 

on the bar graphs horizontal axis.    The default is the last 6 months.    You must enter 
these dates in MM/YY format (i.e. 4/92 to specify April of    1992).



End Month
The Start Month and End Month fields allow you to specify the time period to appear 

on the bar graphs horizontal axis.    The default is the last 6 months.    You must enter 
these dates in MM/YY format (i.e. 4/92 to specify April of 1992).



OK Button
Click the OK button to display the report in a new report window.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



Vs. Income
This checkbox only appears if the Graph Total and the Graph By Expense buttons are 

checked.    If the Vs Income checkbox is checked, a graph is produced containing 2 
bars for each month included in the report.    Each bar represents the total expenses 
or the total income for the month.



Defining the Pie Chart
Use the Pie Chart option on the Report menu to create a Pie Chart of Transaction 

Categories.    The resulting chart shows the distribution of transactions by either 
Expense or Income for the specified time period.    When this option is selected, a 
Dialog Box is selected which allows    parameters to be set:

When you click on OK, a new window is created which contains the Pie Chart.    For more 
information about the Pie Chart, see the topic Understanding the Pie Chart.



Report Title
Enter the title that you want to appear at the top of the graph in the Set Chart Title 

field.    This is also used to title the Report Sub-window, and it used to uniquely 
identify the report if you Memorize it.



Chart By
The Chart by: option allows you to select either Expense categories or Income 

categories.



All Categories
The All Categories checkbox, which is checked by default, indicates that the Pie Chart 

should consist of    all simple categories of the selected type.    If you uncheck this 
box, you can select specific categories for the chart



Select Category
The Select {Expense | Income} Category list box, which appears if the All 

Categories box is unchecked, allows you to select one or more categories for the 
graph. 



Start Date
The Start Date / End Date fields indicate the time span covered by the Pie Chart.      



End Date
The Start Date / End Date fields indicate the time span covered by the Pie Chart.      



OK Button
Click the OK button to display the report in a new report window.



Cancel Button
Press this button to cancel your report definition.



Memorize Button
If you select the Memorize button, then the report definition will be saved.    Saved report

definitions can later be used to create a new report by selecting the Recall option 
under the Report menu.



Recalling Memorized Report Definitions
If you have previously saved one or more report definitions, either by selecting the 

Memorize option from the System menu, or by selecting the Memorize button on a 
report definition Dialog Box, you can access these definitions by selecting the 
Recall... option on the Reports pop-up menu.    

When this option is selected, a Dialog Box is selected which shows the title of each saved 
report definition in a list box.    4 Buttons appear on this Dialog Box:

o View:    If you choose this option, a new report will be created in a new 
window, based on the currently selected report window.    Note that if you 
double-click on any report definition, it is equivalent    to selecting the View 
option.

o Done:    Select this button when you are through creating new reports from 
the saved report definitions.

o Delete:    This button deletes the currently selected report definition.
o Edit:    This button allows you to edit the currently selected report definition.    

When you click this button, the original Report Definition Dialog Box    is 
displayed, allowing you to change the definition parameters.    When you click 
the OK button on the report definition Dialog Box, the report is not created.    
Instead, the modified report definition is saved.    You can then select the View
button to create a report from this report definition.



Copying the Report to the Clipboard
The Clipboard option, located under the Reports menu, is selected to copy the current 

report to the Windows Clipboard.    The report is pasted to the Clipboard in TEXT 
format, with Carriage Return-Line Feed sequences separating the lines, and tab 
characters separating the items on the lines.    The primary purpose of this option is 
to allow the report data to be imported into a Windows spreadsheet program, such as
Microsoft Excel, for further analysis.



Understanding the Account Balance Report
The Account Balance Report shows you the current balance for each of you defined 

Accounts.    The following is an example of a typical Account Balance Report:



Account Name
This area contains the name and Account-type Icon for each of your defined Accounts



Account Balance
This area contains the current balance of the account.    The value is negative if you owe 

money on the account.



Total Balance
This area contains the sum of the balances of each of your defined accounts.



Understanding the Transaction Report
The Transaction Report provides information about selected transactions you have 

entered into Home Accountant.    The following is an example of a typical 
Transaction Report:



Category Name
For Detailed Reports by Category, this field shows the name of the category associated 

with the Transactions that follow.



Transaction Date
This area contains the date that the listed transaction was entered.



Transaction Description
This area contains the transaction description, preceeded by either Expense or Income.



Transaction Amount
This area contains the amount of the transaction.



Category Sub-Total
This value is the total amount of all the transactions listed above for the Category.



Report Total
This value represents the total amount of all transactions shown on the report.



Vertical Scroll Bar
Use this area of the report sub-window to scroll vertically through the report



Horizontal Scroll Bar
Use this area of the report sub-window to scroll horizontally through the report



Understanding the Trends Report
The Trends Report provides you with a monthly summary of activity against one or more 

Categories.    An example of a Trends report is presented below:



Category Name
This area contains the name and icon associated with the category being reported upon.



Expense Amount
This area contains the total amount spent within the category in the month indicated by 

the column heading.



Over/Under Amount
This area contains the difference between the amount spent in this category and the 

category's defined budget amount.    Note that if this is a negative number, it 
indicates that expenses exceeded budget for the month.    This data only appears if 
the Show Over/Under Budget box is checked when the report is defined.



Total Expenses
This area contains the total amount spent in each listed Category by month.



Total Over/Under
The value in this are represent the total variance between the amount spent in each 

listed categories, and the sum of all defined budget values for each listed value.    
This value is negative if expenses exceed budget.



Understanding the Account History Report
The Account History Report provides you with a list of all transactions defined against a 

particular Account for a defined period of time.    The following is an example of an 
Account History report:



Account Name
This area contains the name of the Account being reported upon.



Report Date Range
This area contains the starting and ending date being reported on.



Transaction Date
This area contains the date of the transaction reported by this line.



Transaction Description
This area contains the description associated with the transaction..



Check Number
If a Bank Account is being reported upon, and the transaction was made with a check, 

then this area contains the Check Number.



Debit Amount
If the transaction represents a debit to the account (money was withdrawn), then this 

column contains the transaction amount.



Credit Amount
If the transaction represents a credit to the account (money was deposited), then this 

column contains the transaction amount.



Account Balance
This area contains the balance in the account after the transaction was processed.



Closing Balance
This line of the report contains the Balance within the Account at the end of the last day 

reported on.



Understanding the Budget Variance Report
The Budget Variance shows how you spending compares with your defined budgets for 

one or more expense categories.    Here is an example of a Budget Variance Report



Category Name
This area contains the name of the Category that the following lines in the report refer to.



Month
The month columns indicates for which month the values on this line of the report refer 

to.



Budget
This area contains the Budget value that you have associated with this Category.



Actual Expenses
This column shows you how much was spent during the month for this Category..



Variance
This area contains the difference between the Category's monthly budget, and the 

amount that was spent in the category for the month.



Budget Use Percent
This column contains the percentage of the Category's budget that was used for that 

month.



Budget Use Graph
The horizontal bar chart graphically represents the percentage (on a scale from 0% to 

200%) of the category's budget that was spent during the month.    The bar is drawn 
in green if less than 80% of the category's budget was spent, yellow if between 80% 
and 120% of the budget was spent, and red if spending in the category was over 
budget.



Understanding the Trend Graph
The Trend Graph shows you, in a graphical manner, how much has been spent or earned 

in one or more categories over a series of months.    Here is an example of a Trends 
Graph:

Each bar shown on the chart represents the total expense or income associated with a 
particular category in a particular month.

Once the Bar Graph appears in the window, you can alter the appearance of the graph by
selecting the options that appear on the Graph pull-down menu:  Fonts, Title, 
Options..., Legend, and Category styles.    

You can also Zoom in on the data that appears in a bar graph.    By double clicking on a 
bar in the graph, you will bring up a Transaction Report that shows the details for the 
selected category and month.



Understanding the Pie Chart
The Pie Chart gives you a breakdown of how your expenses are distributed across your 

various expense categories.    Here is an example of a Pie Chart:

Each slice of the pie chart represents the total of each transaction referencing the 
category for the specified period.

Once the Pie Chart appears in the window, you can alter it's appearance by selecting the 
options that appear on the Graph pull-down menu:  Fonts, Title, Legend, and 
Category styles.    

You can also Zoom in on the data that appears in a pie chart.    By double clicking on one 
of the pie segments in the graph, you will bring up a Transaction Report that shows 
the details for the selected category.



Understanding the Future Transactions 
Report

The Future Transactions Report shows you each future transaction defined within a 
particular date range.    Here is an example of a Future Transaction Report:



Date
This area shows the date for which the future transaction is defined.



Type
This area indicates what type of transaction is defined.    Possible values are Expense, 

Income, or Transfer.



Description
The description associated with the future transaction is shown in this area.



Amount
This area contains the Transaction amount.



Understanding the Container Windows
The Container Windows are sub-windows which contain Icons (pictures) representing your

categories and accounts.    The following is an example of what a category container 
window looks like:

The container windows allow you to control your categories and accounts in an intuitive, 
visual manner.    You can manipulate the accounts and categories contained within 
these windows by using the mouse

You create a Container window by selecting the NewContainer... option from either the 
Account or Category pull-down menus.    These options allow you to define which 
categories or accounts you want to appear in the window.    Keep in mind that you 
cannot mix categories and accounts within the same window.

Container windows are stored along with your budget file.    If you create a container 
window and save the budget file, the container window will re-appear when you load 
the file.

You can find out more about container windows by clicking on the topics below:

The Container Window System Menu
Manipulating the Icons in a Container Window



Container Window System Menu
Click on this button to access the Container Window's System menu, which allows you to 

select the Delete, Arrange, New, and Modify options.



Minimize Button
Click on this button to minimize the Container Window (turn it into an Icon)



Maximize Button
Click on this button to maximize the Container Window (make it fill up the entire Home 

Accountant window).



Caption Area
This area contains the name associated with the Container Window.



Container Window Icons
Each Category or Account associated with this Container Window is represented by an 

Icon (picture) within the window.    You can control the categories and accounts by 
manipulating them with the mouse.



The Container Window System Menu
When you access the System Menu for a container window by clicking on the , a pull-

down menu is displayed which contains several useful options.    Four of these options
are unique for container windows, and are described by the following topics:

The Delete Option
The Arrange Option
The New Option
The Modify Option



The Delete Option
The Delete option, selected from the container window system menu, deletes the 

container window.    Note that the accounts or categories contained within the window
are not themselves destroyed.



The Arrange Option
The Arrange option, selected from the container window system menu, physically re-

arranges the positions of each of the account or category icons contained within the 
window.



The New Option
The New option, selected from the container window system menu, is used to create a 

new category or account, depending on the type of icons currently displayed in the 
box.    When you select the New option, a dialog box is displayed which allows you to 
define a new category or account.    Once you complete the definition of the new 
category or account, it is automatically added to the container window.



The Modify Option
Select the Modify option from the container window system menu to modify the title or 

contents of the container window.    When you select this option, the Define new 
container window is displayed, which allows you to modify the window's title or 
contents. 



Manipulating the Icons in a Container 
Window

You can use the mouse to manipulate the icons in a container window, and thereby 
manipulate the accounts and categories which they represent.

You can access the System menu for each icon by clicking on the icon with the left mouse
button.

You can also create a transaction by grabbing the icon with the right mouse button, and 
dragging the icon to another icon in the same window or in a different window.    As 
you drag the Icon with the right mouse button, the background color of the Icon you 
are dragging to will change.    When you let go of the right mouse button, the Define 
Transaction dialog box is displayed, with the Account, Category and Transaction Type 
filled in appropriately.    The following possible actions can be performed:

o If you drag an account icon to another account icon, a Transfer transaction is 
initialized, defining a transfer of funds from the account which was dragged to 
the account it was dragged to.

o If you drag an account icon to a category icon, an expense or income 
transaction is initialized, depending on the category type.

o If you drag a category icon to an account icon, an expense or income 
transaction is defined, again depending on the category type.

o You can drag an account or category icon to a Calendar window in order to 
create a transaction on the day of the month on which you drop the icon.    If 
you drop the icon on a day in the future, Home Accountant automatically 
allows you to define a future transaction.

o You cannot drag a category to another category, nor can you drag an account 
to a major category.

You can also move an account or category from one container window to another by 
grabbing it with the right mouse button and dragging it to an empty area within the 
window you wish to move it to.    Keep in mind that you cannot drag an account icon 
to a container window containing categories, and vice versa.



The Icon System Menu
When you access the System Menu for an icon within a container window by clicking on 

the icon, a pull-down menu is displayed which contains several useful options.    Three
of these options are unique for icons, and are described by the following topics:

The View Option
The Remove Option
The Transactions... Option
The Reports Options



The View Option
The View option on the Container icon system menu can be used to bring up the dialog 

box used to define the account or category.    You can change the definition of the 
account or category by changing the appropriate fields in the dialog box.



The Remove Option
The Remove option on the Container icon system menu is used to remove the category 

or account represented by the Icon from the container window.    Note that you are 
not actually deleting the account or category; you are merely removing it from the 
container window.



The Transactions... Option
The Transactions... option on the Container icon system menu allows you to see the 

Select Transactions   dialog box   for all transactions involving the account or 
category represented by the icon.



The Report Option
When you select the Report option on the Container icon system menu, Home 

Accountant displays a pop-up menu for various the types of reports that can be 
used to display information on the account or category.    Depending on what the icon 
represents, two different menus can be displayed:

o If the icon represents an account, a menu is displayed which contains the 
following options:

o Transactions... allows you create a Transaction report for the 
account.

o Account History... allows you to create an Account History report.

o If the icon represents a category, a menu is displayed which contains the 
following options:

o Transactions... allows you create a Transaction report for the 
category.

o Trends... allows you to create a Expense Trends report.
o Budget Variance... allows you to create a Budget Variance report.
o Trend Graph... allows you to create a Trend Graph report.

Once you select one of the Reports options, the appropriate dialog box is displayed to 
allow you to further define how the report will look.



The Define New Container Window Dialog Box
When you select the New Container... option from either the Account or Category 

pull-down menu, the Define New Container Window Dialog Box is displayed.    This
dialog box allows you to define a new container window.    You can define a title for 
the new window, and select which categories or accounts should be contained within.

Press the OK button to complete the definition of the container window.

You can also reach this dialog box for an existing container window by selecting the 
Modify option from the container window System menu.



Container Window Title
Enter the name you want to give to your container window in this area.



Container Account/Category Selection Box
Select the accounts or categories you want to be included within the container window in 

this area.    You may select more than 1.    Keep in mind that since a category or 
account can be associated with at most one container window, you will only see 
those which are not already associated with another container window.



All Button
Click this button to select all entries in the Select Account/Category box.



None Button
Click this button to de-select all entries in the Select Account/Category box.



OK Button
Click this button when your have completed defining your container window.



Cancel Button
Click this button if you decide that you don't want to define or change your container 

window.





Displaying and Defining Accounts
Use the New option of the Accounts menu to define a new Account.    You are prompted 

with a Dialog Box which will allow you to define the new Account:

Seven items of information can be associated with each account:

o The Name of the Account, such as "Main Bank Account", or "Master Card".    
This field is required.

o A Description for the account.    This can be a longer description of the 
account than can be entered into the Name field.    This field is optional.

o The Current Balance of the account, in dollars and cents.    For a credit card 
account, this could be a negative number, indicating that the card has been 
used for one or more expenses and that money is now owed for the use of the
card.

o The Account Type, which can either be Bank Account, Credit Card, or 
Cash.

o If the account you are defining is a Bank Account, then Home Accountant 
keeps track of the next check number to write.    This information is displayed 
on this dialog box, but you can't change it from here.

o If the account you are defining is a Bank Account, and you wish Home 
Accountant to automatically print checks whenever you create transactions 
involving payments from the account, click on the Check button to bring up 
the Define Check Attributes   Dialog Box  .    This allows you to define the 
attributes of your checks.

o If the account is an interest-bearing bank account, then Home Accountant 
will automatically add the correct amount of interest into the account on a 



periodic basis.    The following information must be provided:
- The annual interest rate;
- The interval for which interest is compounded.    If the interval is 

something other than annual, quarterly, monthly, or daily, click the 
Every: button, and key in the compound interval;

- An income category used for classifying interest income transactions.    
Home Accountant adds interest to an account by creating income 
transactions.    Like any other transaction, a category must be used to 
classify the transaction.    By selecting an income category, you are telling
Home Accountant how to classify these transactions.

- The date that interest was last added to the account.    In order to 
determine when to next add interest into the account, Home 
Accountant must know the last time interest was added.

Clicking the View button allows you to view all the transactions associated with this 
account. The Select Transaction   Dialog Box   is displayed, allowing you to select any 
of the associated transactions for viewing or alteration. 

After defining the information for the Account, click on the OK button to complete the 
definition of the account.    Click on the Cancel button to cancel the new account 
definition.



Account Name
Enter the name to be associated with the account.    This field is required.



Account Description
Enter the a long description to be associated with the account.    This field is optional.



Current Balance
Enter the current balance (in Dollars and Cents) that currently exists within the account.    

If this is a credit card account for which you currently owe money, enter a negative 
number.    This field is required.



Account Type
Click the appropriate button, indicating whether this is a Bank Account, a Credit Card, or 

Cash.



OK Button
Click on this button to complete your definition of a new account, or to save your changes

to an existing account.



Cancel Button
Click on this button to cancel your definition of a new account, or to cancel your changes 

to an existing account.



View Button
When you click on this button, the Select Transaction   Dialog Box   will be displayed, 

containing all transactions that have been recorded against this account.    This Dialog
Box will allow you to view or changes any of these transactions.



Check Button
Click on this button to display the Define Check Attributes   Dialog Box  . This Dialog Box 

allows you to define the physical dimensions of your checks.



Interest Rate
Enter the annual interest rate for the bank account to allow Home Accountant to 

automatically add interest to the account periodically.



Compounded
Enter in this field the frequency that interest is to be added to the account.    If the 

interval is something other than annual, quarterly, monthly, or daily, click the Every: 
button, and key in the compound interval;



Interest Income Category
Select an income category used for classifying interest income transactions.    Home 

Accountant adds interest to an account by creating income transactions.    Like any 
other transaction, a category must be used to classify the transaction.    By selecting 
an income category, you are telling Home Accountant how to classify these 
transactions.

If you type a character on your keyboard, Home Accountant will automatically scroll this
list box to the first category beginning with the character.



Last Compound Date
Enter the date that interest was last added to the account.    In order to determine when 

to next add interest into the account, Home Accountant must know the last time 
interest was added.



Next Check to Write
If the account you are defining is a Bank account, Home Accountant keeps track of the 

check number that you will use on your next transaction in this field.    You can correct
this field by typing a new value into this area.



Viewing Existing Accounts
Use the View option of the Accounts menu to view and possibly alter the definitions and 

current status of existing Accounts.    You are presented with a List Box which shows 
each currently defined account.    Select an Account by either clicking on the account 
name and then on the Select button, or by double-clicking on the account name.    
This will bring up the Define Account   Dialog Box  .    You can view and/or alter 
Account information from this Dialog Box.    

To delete an account, click on the account name and then the Delete button.    The 
account is effectively deleted from the Budget file; however, transactions defined 
against the account are not affected.

Click the Done button to terminate the Select Account Dialog Box.



Defining Check Attributes
If you create a Bank Account, you can indicate that you want Home Accountant to 

automatically print your checks for you whenever you define a transaction involving a
payment from this account.    In order for you to take advantage of this feature, you 
must have the type of printer that will allow you to print directly on the checks 
supplied by your bank.    Most dot-matrix printers have this capability.

In order for Home Accountant to print checks for this account, it is necessary for you to 
define precisely the format of your bank checks.    In particular, you must tell Home 
Accountant the following information:

1. The actual width and height of your checks;
2. The sizes and locations of the following areas on the check:

a. The date;
b. The year;
c. The Pay to the Order Of field;
d. The Check Amount;
e. The Check Amount (in English)

In order to enter this information, you need to click on the Check button from the Define
Account   Dialog Box  .    When this button is checked, the following Dialog Box is 
displayed:

Now, you must carefully measure your checks and determine the required information.    
Note, that the units of measure shown on the screen are dependent upon your choice of 
Measurement within the International section of the Windows Control Panel:    If you 
choose Metric as the Measurement value, then the unit of measure is the millimeter; if you 
choose English, 1/100 of an inch is the unit of measure.



Select an area on the check by either clicking on the area with the left mouse button, or 
by selecting it in within the Define Check Area drop-down list.    The Area 
Definition portion of the screen shows the current attributes of the selected area.    
Note that the location of the area is defined in terms of the distance of the left edge 
of the area baseline from the upper-left corner of the check.

You can modify the definition of the currently selected area by either double-clicking on 
the area with the left mouse button, or by clicking on the View    button.    This will 
cause the Define Check Area Dialog Box to be displayed, and will allow you to re-
specify the dimensions of the selected area.

When you think you are done defining your check attributes, click on the Test button.    
This will cause a check marked "**VOID**" to be sent to your printer using the newly 
defined attributes.    It may be necessary at this point to re-specify your check 
attributes after testing in order to obtain the proper alignment of each printed field 
on the check.

Click OK to complete your check definition, and permanently associate the check 
definition with your Bank Account.    Click Cancel to terminate the check definition 
without saving the result.



Check Width
Define the width of your check in this area.    Width are defined in either 1/100 inches (if 

English is your standard measurement) or millimeters (if Metric is your standard 
measurement).



Check Height
Define the width of your check in this area.    Heights are defined in either 1/100 inches (if 

English is your standard measurement) or millimeters (if Metric is your standard 
measurement).



Check Area Drop Down List
This drop-down list displaysthe name of the currently selected check area.    You can 

select another check area by clicking on the down arrow.



Check Area Characteristics
In this area, the characteristics of the currently selected check area are displayed.    These

characteristics can be changed by clicking the View button.



OK Button
Click on the OK button to complete your definition of the check, and associate this check 

definition with the bank account



Cancel Button
Click on the Cancel button if you decide not to change your check definition.    This 

causes the check definition to revert to it's previous definition.



View Button
Click on this button to modify the definition of the currently selected field.



Test Button
If you click on this button, a test check will be sent to your printer, using the current 

check definition parameters.



Check Date Area
In this area of the check, the current date is printed.    Double click on this area of the 

check to modify the size and location of the current date.



Check Year Area
In this area of the check, the current year is printed.    Double click on this area of the 

check to modify the size and location of the current year.



Pay to the Order Of Field
This is the 'Pay to the Order Of' field.    The 'To' field from the transaction is printed in this 

area.    Double click on this area of the check to modify the size and location of this 
field



Check Amount
In this area of the check, the check amount is printed.    Double click on this area of the 

check to modify the size and location of the amount area.



Check Amount (English)
In this area of the check, the check amount is printed in English words..    Double click on 

this area of the check to modify the size and location of this area.



Defining the Dimensions of a Check Area
The Define Check Area Dialog Box is used to modify the dimensions of an area on your 

check where Home Accountant will print information if automatic check printing is 
selected.    This Dialog box is entered by clicking the button, or by double-clicking a 
check area, on the Define Check Attributes Dialog Box.

4 pieces of information are associated with each check area:

1. The width of the baseline for the area;
2. The height of the printable area above the baseline;
3. The distance of the start of the baseline from the    left edge of the check;
4. The distance of the baseline from the top edge of    the check;

The units of measure shown on the screen depend upon your choice of Measurement 
within the International section of the Windows Control Panel: If you choose Metric 
as the Measurement value, then the unit of measure is the millimeter; if you choose 
English, then 1/100 of an inch is the unit of measure.

When you have entered the dimensions of the check area, click the OK button.    To return
to the Define Check Attributes Dialog Box without saving your changes, click the 
Cancel button.



Check Area Baseline
The Check Area baseline is the pre-printed line on the check which runs underneath the 

area where Home Accountant is to print.    For example, if the Check To area is 
being defined, the baseline is the line which normally runs from the Pay to the 
Order of text.    If the area is defined by a rectangle on the check (such as the check
amount area), then the baseline is the lower horizontal line which bounds the 
rectangle



Defining a New Account Container Window
The New Container... option under the Account menu allows you to either create a new

Account Container Window.    When you select this option, the Define New Account 
Container Window dialog box is displayed, which allows you to define the title of 
the container window, and select which accounts will appear.

The account container window contains an icon (picture) for each account you have 
associated with it.    By manipulating the icons in the window, you can view, modify, 
delete, and create transactions involving the accounts.





Displaying and Defining Simple Categories
Use the New option of the Categories menu to define a new Category.    Use this 

function to define a new simple category.    You are prompted with a Dialog Box which 
will allow you to define the new Category.    

Five items of information can be associated with each category:

o The Name of the Category, such as "Groceries", or "Bill's Salary".    This field is
required.

o A Description for the category.    This can be a longer description for the 
category than can be entered into the Name field.    This field is optional.

o The Monthly Budget for the category.    This is only valid if the category type is 
Expense.    You enter into this field the amount you anticipate spending each 
month in this category.    The amount entered into this field is used by the 
Warn if Over Budget feature.

o The Category Type, which can either be Expense or Income.
o An Icon (picture) to be associated with the category.      This Icon is displayed 

next to the category name whenever it appears in a selection box. Choose one
of the available Icons in the Select Icon box.

If you are looking at or altering an existing category, and the category type is Expense, 
the Dialog Box displays another field called Month Expenses.    This field indicates 
how much has been spent so far this month in this expense category.

Clicking the View button allows you to view all the transactions associated with this 
category. The Select Transaction   Dialog Box   is displayed, allowing you to select any
of the associated transactions for viewing or alteration. 

After defining the information for the Category, click on the OK button to complete the 
definition of the category.    Click on the Cancel button to cancel the new category 
definition.





Category Name
Enter the name to be associated with the category.    This field is required.



Category Description
Enter the a long description to be associated with the category.    This field is optional.



Monthly Budget
The Monthly Budget for the category.    Enter into this field the amount you anticipate 

spending each month in this expense category.



Category Type
Click the appropriate button, indicating whether this is an Expense or Income category.



Category Icon
If you wish, you can select a picture, or Icon to be associated with this Category.    This is 

optional



OK Button
Click on this button to complete your definition of a new category, or to save your 

changes to an existing category.



Cancel Button
Click on this button to cancel your definition of a new category, or to cancel your changes

to an existing category.



View Button
When you click on this button, the Select Transaction   Dialog Box   will be displayed, 

containing all transactions that have been recorded against this category.    This 
Dialog Box will allow you to view or changes any of these transactions.



% of Budget Spent
This Horizontal Bar Chart indicates, in graphical format, the percentage of the category's 

monthly budget that has been spent so far this month.    The bar is drawn green if 
current expenses are less than 80% of the budget, yellow if expenses are between 80
and 100% of the budget, and red if the current monthly budget has been exceeded.



Month Expenses
This field contains the total expenses so far this month defined within this category.    This 

field does not appear if the Category type is Income.    For a new Category, this field 
will contain 0.



Creating Major Categories
Use the Major... option of the Categories menu to define a new Major Category.        You 

are prompted with a Dialog Box which will allow you to define the new Major 
Category.    

Six items of information can be associated with each Major category:

o The Name of the Category, such as "Groceries", or "Bill's Salary".    This field is
required.

o A Description for the category.    This can be a longer description of the 
category than can be entered into the Name field.    This field is optional.

o The Monthly Budget for the category.    This is only valid if the category type is 
Expense.    You enter into this field the amount you anticipate spending each 
month in this category.    The amount entered into this field is used by the 
Warn if Over Budget feature.

o The Category Type, which can either be Expense or Income.
o An Icon (picture) to be associated with the category.      This Icon is displayed 

next to the category name whenever it appears in a selection box. Choose one
of the available Icons in the Select Icon box.

o The categories that will be associated with this Major Categories are selected 
in the Select Sub-Categories list box.    Select the sub-categories that are to 
be associated with this Major Category.

If you are looking at or altering an existing category, and the category type is Expense, 
the Dialog Box displays another field called Month Expenses.    This field indicates 
how much has been spent so far this month in this expense category.

Clicking the View button allows you to view all the transactions associated with this 



category. The Select Transaction   Dialog Box   is displayed, allowing you to select any
of the associated transactions for viewing or alteration. 

After defining the information for the Major Category, click on the OK button to complete 
the definition of the category.    Click on the Cancel button to cancel the new Major 
Category definition.



Major Category Sub-Categories
Select in this list box the categories that will be associated with this Major Category.



Viewing Existing Categories
Use the View option of the Categories menu to view and possibly alter the definitions 

and current status of existing Categories.    You are presented with a List Box which 
shows each currently defined category.    Select a category by either clicking on the 
category name and then on the Select button, or by double-clicking on the category 
name.    This will bring up the Define Category   Dialog Box  newcat.    You can view 
and/or alter Category information from this Dialog Box.    

To delete an Category, click on the name and then the Delete button.    The category is 
effectively deleted from the Budget file; however, transactions defined against the 
category are not affected.

Click the Done button to terminate the Select Category Dialog Box.



Merging Categories
The Merge option on the Category pop-up menu is used to create new expense or 

income categories by merging old simple categories together.    When you merge 
categories, Home Accountant defines a new category with the name you specify, 
deletes one or more existing categories, and modifies all existing transactions that 
reference any of the deleted categories to now reference the new category.    

When you select the Merge option, the Category Merge Dialog Box is displayed:

Key in the name of the new category in the field labelled New Category Name.    This 
name may not duplicate the name of any existing category, although it may have the
same name as one of the categories that you select to be merged.

You may also key in an optional description for the category.

You can define the new category as either an Expense or an Income.    The list box    
underneath the Select Categories to Merge prompt is filled with each defined 
Category of the type you select.    You can select one or more categories in this box 
for merging.    These categories are deleted when you merge them into the new 
category.

You can optionally associate an ICON with the category.    This ICON is displayed next to 
the category name whenever it appears in a selection box. Choose one of the 
available ICONs in the Select Icon box.

Click the OK button to complete the Category merge process.    Click the Cancel button 
to return without performing a category merge.



Defining a New Category Container Window
The New Container... option under the Category menu allows you to either create a 

new Category Container Window.    When you select this option, the Define New 
Category Container Window dialog box is displayed, which allows you to define 
the title of the container window, and select which categories will appear.

The category container window contains an icon (picture) for each category you have 
associated with it.    By manipulating the icons in the window, you can view, modify, 
delete, and create transactions involving the categories.





Displaying and Defining Transactions
Use the New option of the Transaction menu to define a new Transaction.    You are 

prompted with a Dialog Box which will allow you to define the new Transaction.    Here
is what the Transaction Dialog Box looks like:

The following items of information can be associated with each transaction:

o The Date and Time that the transaction took place.    
o A Description for the transaction.    This field is required.
o A To field for the transaction.    This field is required for an Expense 

Transaction, and is optional for other types of Transactions.    This field 
indicates the party to which a payment for an expense transaction was made.

o The Amount of the Transaction, in dollars and cents.    This field is required.
o The Transaction Type: this can be either Expense, Income, or Transfer.
o You must also define the Account(s) and Category associated with this 

transaction.    These are specified in two drop-down lists whose contents 
depend on the Transaction Type:
- Expense:    Pick the account from which the money for the transaction is 

coming from in the left box.    Pick the expense category in the right box.
- Income: Pick the account into which the money is to be deposited in the 

left box.    Pick the income category in the right box.
- Transfer: Pick the account where the money is being transferred from in 

the left box.    The account that the money is being transferred to is 
selected in the right box.

o If you are defining an Expense or Transfer Transaction, and the Account is a 
Bank Account, then an additional field appear on the screen.    This field is 
the Check Number field.    You can key in the number of the check written for 



the Expense or Transfer    in this field.    Home Accountant automatically 
keeps track of the next check number to write, and fills the number into this 
field when you select the Account.      If the transaction did not involve writing 
a check, the Check Number field should be 0.

o If you are defining an Expense or Transfer Transaction, and the Account is a 
Bank Account or Credit Card, then another additional field appear on the 
screen.    This field is the the Reconciled button.    The Reconciled button can
be checked to indicated that this Transaction has been reconciled with your 
Bank or Credit Card Statement.

o You can attach a note to the transaction by means of the Note button.    
Clicking on this button brings up the Attach Note to Transaction Dialog 
Box.    This dialog box allows you to enter and/or edit a note that is to be 
associated with the transaction.

Note that you can only associate a simple category with 
your Expense or Income transaction.

If you find that the account and/or category you want to associate with the transaction 
does not currently exist, you can dynamically create the account or category.    Click 
the left New button to create a new Account, or the right New button to create a new
Category.    Clicking either of these buttons will cause the corresponding Create 
Dialog Box to appear.    Once you define the Account or Category, the new item is 
placed in the selection field of the corresponding drop-down list.

Click on the Memorize button to cause the information on the screen to be stored as a 
Memorized transaction.    Memorized transactions can be later recalled and used to 
create new transactions.

The Split button is used to create multiple transactions (either expense or income) that 
are performed at the same time, defined against the same account, but need to be 
associated with different categories.    An example of splitting a transaction may 
occur if you go to the grocery store to buy groceries, but also purchase some 
household items at the same time.    You could enter the purchase as two separate 
transactions, but the Split button offers a short cut.    It allows you to enter the 
information common to the transactions on the Define Transaction screen, then 
enter the Descriptions, Categories, and amounts on another screen.    You can split 
new transactions, or existing transactions.    When you click on the Split button, the 
Split Transaction dialog box is displayed.

Click the Copy to copy the data in the current transaction (as defined on the screen) to 
the Windows Clipboard.    You can later restore the data into another transaction by 
using the Paste button.

After defining the information for the Transaction, click on the OK button to complete the 
definition of the transaction.    The accounts and/or categories affected by the 
transaction are automatically updated.    If the Print Checks option is enabled, and 
the Account selected is a Bank Account, then a new check may be printed at this 
point.    See the Automatic Printing of Checks topic for more details.



Date
Fill in the date that the transaction occurred.    The format of the date is sensitive to the 

setting of the International Date Format in the Windows Control Panel.



Date Increment/Decrement Buttons
Use these buttons to increment or decrement the Date one day at a time.



Time
Fill in the time that the transaction occurred, in HH:MM:SS format.



OK Button
Click on this button when you are done defining a transaction.



Description
Key in a description for the transaction.    This field is required.



To Field
For Expense or Income transactions, specify the name of the party with whom the 

transaction was conducted.    Click on the down arrow button to select one of the 20 
previously-entered To field values.



Amount
Fill in the amount of the transaction, in dollars and cents (cents are optional).



Transaction Type
Click the appropriate button, depending on whether your transaction is an expense, 

income, or transfer.



Cancel
Click this button to cancel the definition of the current transaction.



Split
If you click this button, the Split Transaction Dialog Box will appear.    This allows you 

split a new or existing transaction into several transactions that were performed at 
the same time, and involved the same account



Memorize
Click on this button to cause the information on the screen to be stored as a Memorized 

transaction.



Account Box
Select the Account involved in the transaction in this box.    For Transfer transactions, 

select the 'From' account.
If you type a character on your keyboard, Home Accountant will automatically scroll this

list box to the first account beginning with the character.



Category Box
Select the Simple Category involved in the transaction in this box.    For Transfer 

transactions, select the 'To' account in this box.
If you type a character on your keyboard, Home Accountant will automatically scroll this

list box to the first category or account beginning with the character.



New Account Button
Click on this button to create a new account by means of the Create Account Dialog 

Box.



New Category Button
Click on this button to create a new category by means of the Create Category Dialog 

Box.



Note Button
Click on this button to bring up the Attach Note to Transaction Dialog Box.    This 

allows you to create a note and attach it to the transaction you are defining.



Copy Button
Click on this button to copy the transaction definition you see on the screen into the 

Windows Clipboard.    You can later recall this information into another Transaction 
definition with the Paste button.



Paste Button
Click on this button to restore the transaction definition that you previously saved in the 

Windows clipboard with the Copy button.    When you click this button, all fields in the
dialog box are replaced with the values in the Pasted transaction.



Contains Note Checkbox
This contains a checkmark if there is a note associated with this transaction.    This field is 

not directly modifiable; click on the Note button to define a note and associate it with
the transaction



Automatic Printing of Checks
When you complete the definition of a new transaction by clicking the OK button, a new 

check will be printed only under the following circumstances:

1. You have enabled the Print Checks option under the Options menu;
2. The transaction is a new transaction (i.e., not a modification of an existing 

transaction).
3. The transaction is an expense or transfer;
4. The account associated with the expense, or the From-account associated with

the transfer, is a Bank Account;
5. There is a Check Number defined for the transaction;
6. The Define Check Attributes Dialog Box has been used to define the check 

attributes for the Bank Account.



Viewing Existing Transactions
Use the View option of the Transactions menu to view and possibly alter the definitions 

of existing Transactions.    You are presented with a List Box which shows the dates 
and descriptions of each currently defined transaction.    Select a transaction by either
clicking on the transaction and then on the Select button, or by double-clicking on 
the transaction.    This will bring up the Define Transaction   Dialog Box  .    You can 
view and/or alter Transaction information from this Dialog Box.    The last 500 
transactions you defined will appear, in reverse chronological order.

To delete a Transaction, click on the name and then the Delete button.    The Transaction   
is deleted from the Budget file.    The transactions is 'backed-out' of the file: i.e., the 
effect that the transaction had on the defined Account and/or Category is reversed, 
as if the transaction had never taken place.

Click the Done button to terminate the Select Transaction Dialog Box.



The Split Transaction Dialog Box
When you click on the Split button from the Define Transaction   dialog box  , the Split 

Transaction dialog box appears.    This dialog allows you to take a transaction (either
new or pre-existing) and create multiple transactions.    All the transactions share the 
same Date, Time, To field, Check Number, and Account fields, but each has a unique 
Description, Category, and Amount.    You enter the last three fields for each 
transaction on the Split Transaction dialog box.    When you click the OK button, a 
transaction is created for each line on the screen for which you have entered data.



Attaching a Note to a Transaction
When you click the Note button from the Define Transaction Dialog Box, the Attach 

Note to Transaction Dialog Box appears.    This feature allows you to enter a note of
up to 4000 characters and associate the note with the transaction you are defining.    
The dialog box contains an area where text can be viewed or edited.    There are also 
two pull-down menu option: File and Edit.    The following options can be selected 
from these menus:

Import Option (from the File menu)
Use this option to replace the current note with the contents of another file.    When this 

option is selected, the Select File to Import Dialog Box appears, allowing you to 
select the file to read.    If the file you select is bigger than the maximum note size 
(4000 characters), it is truncated.

Cancel Option (from the File menu)
When you select this option, any changes you have made to the note are thrown away, 

and you return to the Define Transaction Dialog Box.
Exit Option (from the File menu)
When this option is selected, the note is saved, and control returns to the Define 

Transaction Dialog Box.
Undo Option (from the Edit menu)
Select this option to 'Undo' the last change you made to the note.
Cut Option (from the Edit menu)
When you select this option, the currently selected text is removed from the note and 

placed in the Windows clipboard.    You can recall this text from the clipboard with the 
Paste option on the File menu.

Copy Option (from the Edit menu)
When you select this option, the currently selected text is copied to the Windows 

clipboard and kept in the note.    
Paste Option (from the Edit menu)
Select this option to insert the text in the Clipboard into the note, replacing any selected 

text.

When you are done editing the note, click the OK button to save the note.    Click the 
Cancel note to throw out any changes you have made.    



Recalling Memorized Transactions
Use the Recall option of the Transactions menu to view and possibly use the current set

of Memorized Transactions.    You are presented with a List Box which shows the 
descriptions of each currently defined memorized transaction.    Select a transaction 
by either clicking on the transaction and then on the Select button, or by double-
clicking on the transaction.    This will bring up the Define Transaction Dialog Box.    
You can view and/or alter Transaction information from this Dialog Box.    The 
appropriate fields in the Dialog Box are filled in with the information from the 
memorized transaction, with the exception of the date and time, which are filled in 
from the current date and time.

To delete a memorized Transaction, click on the name and then the Delete button.    The 
Transaction    is deleted from the Budget file.    

Click the Done button to terminate the Select Memorized Transaction Dialog Box.



Defining Future Transactions
The New sub-option on the Future option of the Transaction pull-down menu allows 

you to define Future transactions.    Future transactions are nothing more than 
automated remainders to yourself that a transaction will have to be made at a future 
point in time.    

When you select this option, the Define Future Transaction Dialog Box is selected.    
The following information must be set:

o The Date that the transaction will take place.    This date must be greater than
today's date.

o The Recurrence area.    If you define the future transaction as either Daily, 
Weekly, or Monthly, then the future transaction will automatically re-
schedule itself based upon this setting.    If the None box is checked, then the 
future transaction will occur once only.

o A Description for the transaction.    This field is required.
o A To field for the transaction.    This field is required for an Expense 

Transaction, and is optional for other types of Transactions.    This field 
indicates the party to which a payment for an expense transaction will be 
made.

o The Amount of the Transaction, in dollars and cents.    This field is required.
o The Transaction Type: this can be either Expense, Income, or Transfer.
o You must also define the Account(s) and Category associated with this 

transaction.    These are specified in two drop-down lists whose contents 
depend on the Transaction Type:
- Expense:    Pick the account from which the money for the transaction is 

coming from in the left box.    Pick the expense category in the right box.
- Income: Pick the account into which the money is to be deposited in the 

left box.    Pick the income category in the right box.
- Transfer: Pick the account where the money is being transferred from in 

the left box.    The account that the money is being transferred to is 
selected in the right box.

Click the Copy to copy the data in the current transaction (as defined on the screen) to 
the Windows Clipboard.    You can later restore the data into another transaction by 
using the Paste button.

When the date associated with the transaction occurs, the Define Transaction Dialog 
Box automatically appears on the screen.    It contains the information you stored in 
the Future transaction which you can verify and/or change prior to entering it as a 
real transaction.    The future transaction is automatically re-scheduled if you selected
Daily, Weekly, or Monthly as the Recurrence setting.

After defining the information for the Transaction, click on the OK button to complete the 
definition of the future transaction.    Click on the Cancel button to cancel the new 
future Transaction.



Date
Fill in the date that the transaction will occur.    The format of the date is sensitive to the 

setting of the International Date Format in the Windows Control Panel.



Recurrence
Indicates that the future transaction will recur on a regular basis in the future.    Click on 

the Daily, Weekly, or Monthly button to cause the transaction to be automatically 
re-scheduled.    Click on None to define a one-time only future transaction.



Viewing Future Transactions
Use the View sub-option on the Future option of the Transaction pull-down menu to 

view and possibly alter the definitions and current status of existing Future 
Transactions.    You are presented with a List Box which shows each currently defined 
future transaction.    Select a Transaction by either clicking on the entry and then on 
the Select button, or by double-clicking on the entry.    This will bring up the Define 
Future Transaction   Dialog Box  .    You can view and/or alter future transaction 
information from this Dialog Box.    

To delete a future transaction, click on the entry and then the Delete button.    

Click the Done button to terminate the Select Future Transaction Dialog Box.



Consolidating Transactions
Use the Consolidate option of the Transactions menu to consolidate old transactions 

by category and possibly by account.    When you consolidate transactions, you lose 
detailed information about individual transactions and create consolidated 
transactions records.    Consolidated transactions contain the sum of all activity for a 
month in a particular category.

The Transaction Consolidation Dialog Box allows you to enter three fields:

o The Date field which indicates the range of transaction dates for which 
consolidation is to take place.

o The Maximum Value for Consolidated Transactions field. Only 
transactions which have amounts less than or equal to this value are 
consolidated.    If this field is blank, all transactions are consolidated.

o The Track by Account button, which indicates that you want to consolidate 
by account, as well as by category.    If you select this option, Home 
Accountant will consolidate transactions for the same category, account, and
month.    If this option is not selected, transactions are consolidated only by 
category and month, and account information is effectively lost.

Description fields for consolidation records always contain the word Consolidation 
followed by the category name.    The date of the transaction is the first day of the 
consolidated month.

If you are keeping multiple copies of your budget file, and using the Export and Import 
options to keep the files in sync, you should only perform consolidation when working
with the "Master" Budget File.    You should recreate each of the duplicate files from 
the master file after performing consolidation.



Searching for Transactions
Use the Search option of the Transactions menu to search through the entire set of 

defined transactions looking for those transactions that contain certain text in the 
Description or To fields.    When you select the Search option, a Dialog Box is 
displayed which then allows you to enter the parameters for the search:

The Next option from the Transactions menu is used to continue the search by locating 
the next matching transaction.    This option is only valid if the original search did not 
use the Find All option.    When Next is selected, the next Transaction which 
matches the original search parameters is displayed in the Define Transaction     
Dialog Box.



Enter Text to Search For
Enter the text you want to search for in this field.    The Description field and/or the To 

field of the transactions will be searched for a match.



Ignore Case Button
Check this button to cause the search to ignore upper/lower case when making the 

search.    If this box is blank, the search is case-sensitive.



Find All Button
This button is used to specify that you want to locate all transaction entries containing 

the specified text with a single search.    If you click this option, a new Report Window 
is created which will contain line items for each matching Transaction.    If the button 
is not checked, the first transaction that satisfies the request is displayed.



Exact or Containing Buttons
Exact Match means that the specified search text must exactly match the text in the 

Description or To fields in order to satisfy the search.    If Containing is selected, it 
means that the Description or To fields must only contain the specified search text 
in order to be considered a match.



Fields to Search
These two checkboxes indicate which fields of the transactions should be searched for the

specified text.    At least one of these boxes must be checked.    Both boxes may be 
checked, which indicates that a match will occur if the text is found in either the 
Description or the To fields.



Search Direction
Use these buttons to indicate in which order the search is to proceed.    Select Forward to

start the search at the beginning of the Transactions; select Backward to begin the 
search at the end.



OK Button
Click on the OK button to cause the specified search to proceed.



Cancel Button
Click on the Cancel button to cancel your search request.



Start Date
Enter the date, in standard format, the search is to start.    This field is optional.    If it is 

entered it indicates that transactions prior to this date will not match the search.



End Date
Enter the date, in standard format, the search is to end.    This field is optional.    If it is 

entered it indicates that transactions after this date will not match the search.



Transaction Reconcilliation
Use the Reconcile option of the Transactions menu to reconcile the transactions you 

have defined against your Bank or Credit Card Statement.    When you select this 
option, a pop-up menu is displayed showing each of your defined Bank or Credit Card 
Accounts.    Select the Account for which you wish to perform reconcilliation, and the 
Transaction Reconcilliation Dialog Box is displayed.

The Transaction Reconcilliation Dialog Box allows you to see each unreconciled 
Expense or Transfer Transaction defined against the selected Account.    Each 
Transaction is represented by an item in a list box, showing the check number (if the 
account is a bank account), the date of the Transaction, the Transaction amount, and 
the To field entered in the transaction.    The total amount of all the unreconciled 
transactions appears at the bottom of the Dialog Box.    By selecting a transaction and
clicking on the Reconcile button, or by double-clicking on an item, you will cause the
Reconcile flag to be turned on for the transaction.    You will normally do this when 
you receive your statement from the Bank and wish to mark each transaction 
appropriately.





The Auto Save Option
If the Auto Save option of the Options menu is checked, it means that the budget file is 

automatically saved to Disk whenever you define a new transaction.    This is 
convenient as it reduces the risk that transaction definitions will be lost because of an
unexpected outage prior to a manual save.



The Auto Refresh Option
The Auto Refresh option allows you to specify whether or not Home Accountant 

should automatically refresh reports you have created on a periodic basis.

Normally, when you define a report, the contents of the report are not updated to reflect 
any changes that you make to the data.    For example, if you create a Transaction 
detail report, then define a new transaction, the new transaction will not show up in 
the report.

When Auto Refresh is enabled, Home Accountant will refresh each active report with 
the most current data defined to Home Accountant.    It is as if each report was 
redefined and recreated from scratch.

The Define Auto Refresh Interval Dialog Box allows you to specify how Home 
Accountant should refresh report windows.    3 options are possible:

o You can indicate that all report windows should be refreshed on a periodic 
basis.

o You can indicate that only text-based (non-graphic) report windows should be
refreshed.

o You can disable Auto Refresh.

If either of the first two options are selected, you can specify the auto refresh interval in 
the input field labelled Refresh reports every ... seconds.



The Warn if Over Budget Option
If the Warn if Over Budget option of the Options menu is checked, it means that 

Home Accountant will check the expense category each time an expense 
transaction is defined to see if the monthly budget for the category has been 
exceeded.    If the budget is exceeded, a warning message box is displayed.



The Auto Backup Option
If the AutoBackup option of the Options menu is checked, Home Accountant will 

automatically create a backup copy of the Budget File the first time you change it 
after loading it.    The name of the backup file will be the same as the original file, 
except it will have a '.BAK' suffix instead of '.BGT'.    A Message Box will let you know 
when this backup file is being created.



The Allow Duplicate Transactions Option
Home Accountant will not normally allow you to create two transactions with the same 

description and the same date.    If the Allow Duplicate Transactions selection of 
the Options menu is checked, however, duplicate transactions will be allowed.



The Print Checks Option
If the Print Checks option is checked, it means that Home Accountant automatically 

prints checks whenever you define a transaction involving a payment made from a 
Bank Account for which you have defined check attributes.    For more information 
about this process, see the topic Automatic Printing of Checks.



The Show Icons Options
If this option is checked,    Home Accountant displays the icon (picture) associated with 

a Category or Account in reports or list boxes.    If this option is not checked, the icons
are not displayed.



The Compress Option
When the Compress option is checked, it means that the next time the Budget file is 

saved to your disk, it will be written in a compressed format.    This saves space on 
your hard disk, although it takes longer to save and open compressed files than 
normal files.

You don't need to set this option prior to OPENing a compressed Budget file.    Home 
Accountant will figure out whether the file you are trying to open is in normal or 
compressed format, and set the option accordingly.    You can change this option 
yourself, but Home Accountant will always re-set the option when you open a file.



The Toolbar Options
The set of options located within the Toolbar pop-up menu under the Options menu is 

used to manipulate the toolbar.    The toolbar is the area of the screen where 
graphical push buttons which offer shortcuts to commonly-used Home Accountant 
functions are located.    There are three styles of toolbars available, and they can be 
activated by selecting the appropriate entry within the Toolbar popup:

The small toolbar consists of 15 graphical pushbuttons located along the top of the
main window, just underneath the menu items.

The large toolbar consists of 8 large pushbuttons located along the top of the main
window, just underneath the menu items.    Each pushbutton contains text 
describing it's function.    The large toolbar can be customized by means of the
Customize option.

The floating toolbar consists of 15 pushbuttons located in a moveable window that
can be repositioned anywhere on the screen

The current format for the toolbar is indicated with a checkmark next to the appropriate 
option.    If you want the toolbar deleted from the screen entirely, select the Toolbar 
option that currently is checked.

See the topic Using the Toolbar in order to learn more about how to use the Toolbar.



Using the Toolbar
The Toolbar is the area of the screen    that contains graphical push-buttons representing 

shortcuts to several commonly-used Home Accountant functions.    A click with the 
mouse is the equivalent of activating these functions through the menu.    Depending 
on the type of toolbar being displayed (see the topic The Toolbar Options), each 
button has two possible formats.    Both are shown below:

This button is used to quickly access help for Home Accountant.    Clicking on this 
button is the equivalent of Selecting Introduction from the Help menu.

Use this button to exit from HomeAccountant.    It is the equivalent of selecting the Exit 
option from the Files menu.

Clicking this button is the equivalent of selecting Open from the Files menu.

Clicking this button saves the current budget file.    It is like selecting the Save option 
from the Files menu.

Clicking this button prints the current report or graph.    It is like selecting the Print option
from the Files menu.



Click this button to define a new transaction.    It is the equivalent of selecting New from 
the Transaction menu.

This button recalls memorized transactions, like the Recall option on the Transaction 
menu.

Click this button to bring up the Search   Dialog Box  .    It is the equivalent of selecting the 
Search option from the Transaction menu.

This button continues a previous search, like the Next option on the Transaction menu.   

Clicking this button allows you to define a transaction report.    It is the same as selecting 
Transaction from the Report menu.

Selecting this button creates a Trends report, as if you had selected Trends from the 
Report menu.

This button represent the Account History option from the Reports menu.    If you click 
this button, the Account History dialog box appears.



If you select this button, the Create Transaction Trends Bar Graph Dialog Box is 
displayed, allowing you to define a Transactions Bar Graph.

If you select this button, the Create Category Pie Chart Dialog Box is displayed, 
allowing you to define a Category Pie Chart.

If you select this button, a new Calendar sub-window is created.    This is the same as if 
you had selected the Calendar option from the Options menu.



Customizing the Toolbar
If you select the Large-format from the Toolbar option, only 8 of 15 possible pushbuttons 

can be displayed on the screen.    Home Accountant provides you with the ability of 
choosing which of the 15 available buttons you want displayed by means of the 
Toolbar Customize option.    When you select this option, the following Dialog Box is
displayed:

The area near the top of the Dialog Box shows you the current configuration of the large 
toolbar.    The listbox in the center of the Dialog Box shows you each of the 15 
possible large-format pushbuttons.    Use the following procedure to re-configure a 
button on the toolbar:

1. Select the button position by clicking on the appropriate button in the Current 
Toolbar Display Area;

2. Select the button you wish to place into this area within the Pushbutton 
Selection Listbox;

3. Place the selected button into the selected toolbar position by either pressing 
the Select button, or by double-clicking the selected button within the 
Pushbutton Selection Listbox.

4. When you are through making your changes to the toolbar, press the OK 
button.



Current Toolbar Display Area
This area shows you which pushbuttons are currently displayed in the large toolbar.    To 

select one of these buttons for replacement, click the button within this area with the 
mouse.    A red outline should appear around the button.



Pushbutton Selection Listbox
By scrolling through this listbox, you can see which large toolbar pushbuttons are 

available and the menu shortcut functions each of them perform.    To replace a 
pushbutton in large toolbar, first select the button position in the Current Toolbar 
Display_Area, then double-click on the desired pushbutton in the listbox.



Select Button
Push this button to place the currently selected button within the Pushbutton Selection 

Listbox into the currently selected toolbar position within the Current Toolbar 
Display_Area.



OK Button
Push this button when you are through customizing the Toolbar and you wish to save the 

changes you have made.



Cancel Button
Push this button if you decide to discard the toolbar changes you have made, and wish to 

return to Home Accountant.



The Calculator Option
The Calculator option, from the Options menu, is merely a convenient method of 

accessing the Windows Calculator function.    When you invoke this option, the 
standard Windows calculator appears in a separate Window.



The Calendar Option
The Calendar option, from the Options menu, allows a month calendar to appear in a 

new report sub-window.    When this option is selected, a new sub-window is created, 
containing a calendar for the current month.    

The next topic contains information about how this calendar can be used.



Using the Calendar
A Calendar sub-window contains a monthly calendar.    The month represented by the 

calendar is indicated in the Window title.    Each day of the month is represented by a 
gray rectangular button.    One of the buttons is depressed and shows the day of the 
month in red:    the day represented by this button is known as the current day.

If any future transactions are defined, then the icon which represents the transaction 
appears on the date for which the future transaction is scheduled.

You can use the mouse to zoom in on any day of the month and obtain more information 
about your financial activities for that day:

o If you move the mouse cursor over any day of the month and press either the 
left or right mouse button, you will cause that day to become the current day.  

o If you double click the left mouse button, a new report window is created.    
The type of report which appears in the window depends on the current day:
- If the current day is equal to or prior to today's date, a Transaction 

Detail report appears, showing all transactions entered on the current 
day.

- If the current day is in the future, then a Future Transactions report 
appears, displaying all future transactions defined for that day.

o If you double click the right mouse button, you can easily create a new 
Transaction for the current day.    The type of transaction you create depends 
on whether or not the current day is a past or future date:
- If the current day is earlier or equal to today's date, then the Define 

Transaction Dialog Box is displayed, pre-initialized with the current day.
- If the current day is in the future, then the Define Future Transaction 

Dialog Box is displayed, pre-set    with the current day.

You can drag an account or category icon from a container window onto a day on the 
calendar in order to create a transaction or future transaction for that day.

You can also use the vertical scroll bar on the right of the window to scroll from week to 
week or from month to month.

In addition to using the mouse, you can use the keyboard interface to manipulate the 
Calendar window:

o Press the right arrow key to make the next day the current day.
o Press the left arrow key to make the previous day the current day.
o Press the down arrow key to advance the current day 1 week.
o Press the up arrow key to decrease the current day by 1 week.
o Press the Page Up key to make the first day of the next month the current 

day.
o Press the Page Down key to make the first day of the prior month the current

day.
o Press the Home key to make the first day of the current month the current 

day.
o Press the End key to make the last day of the current month the current day.
o Press the Enter key to zoom in on the current day.    This will cause a 

Transaction Detail report or Future Transaction report to be created for the 
current day.    



o If you hold down the Shift key while you press Enter, you can easily create a 
new Transaction for the current day.    The type of transaction you create 
depends on whether or not the current day is a past or future date:
- If the current day is earlier or equal to today's date, then the Define 

Transaction Dialog Box is displayed, pre-initialized with the current day.
- If the current day is in the future, then the Define Future Transaction 

Dialog Box is displayed, pre-set    with the current day.

When the topmost sub-window within Home Accountant is a Calendar, then the 
Calendar pull-down menu appears.    This menu contains three options: Next Month, 
Prior Month, and Go To Date...



Current Day
On a calendar window, the Current Day is the day represented by the depressed button 

with red lettering.    Most navigation with the calendar involves the current day.



The Mortage Calculator
When you select the Mortgage Calculator option from the Options pull-down 

message, the Mortage Payment Calculator Dialog Box appears.    The calculator 
allows to determine the payment amount for a standard amortized loan, given the 
initial loan amount, annual interest rate, and payment frequency.    The calculator 
can also generate a Payment Schedule report, which shows payment-by-payment 
how much of the payment is interest, and how much is going toward the principal.



Schedule Button
Click this button to produce a Loan Payment Schedule report in a new report window.    

This report shows you on a payment-by-payment basis how much each payment is 
interest, and how much goes toward the principal.



Cancel Button
Click this button when you are done with the Mortage Calculator.



Interest Rate
Enter the annual interest rate for the loan in this box.    For example, enter 7.25 to define

an annual interest rate of 7 1/4 %.



Loan Amount
Enter the original Loan Amount in this area: for example, 100,000.



Payment
When you click on the Schedule or Calculate buttons, the loan payment amount 

appears in this area.



Payments per Year
Enter the number of payments per year in this area.    For example, enter 12 if the 

payments are made each month.



Length of Loan
Enter the length of the Loan (in years) into this field.



Calculate Button
Click this button to determine the loan payment.    You must enter the Interest Rate, Loan

Amount, Length of Loan, and Payments per Year prior to clicking this button.





The Window Option
Use the Window option of the Main Menu to display a set of options for controlling the 

appearance and behavior of the report sub-menus appearing within Home 
Accountant.    Four options always appear:    Tile, Cascade, Arrange Icons, and Close 
All.    In addition, the title of each currently defined report window appears.    To make 
one of these reports into the currently active sub-window, simply select it.



The Tile Option
Use the Tile option to cause Home Accountant to arrange each of the report sub-

windows in a tiled fashion.



The Cascade Option
Use the Cascade option to cause Home Accountant to arrange each of the report sub-

windows in a "cascade"    fashion.



The Arrange Icons Option
Use the Arrange Icons option to cause Home Accountant to arrange the icons which 

represent the minimized report sub-windows.



The Close All Option
Use the Close All option to cause Home Accountant to close all report sub-windows.





Changing the Fonts on the Chart
The Fonts option on the Graph pull-down menu allow you to change the appearance of 

text on the Chart.    Three sub-options are displayed when you select this option: 
Title..., Axis... (for Bar Charts only), and Legend....    When either of these options 
are selected, Home Accountant displays a standard Font editing Dialog Box, 
allowing you to enter the characteristics for the font being altered.



Changing the Chart Title
Use the Title... option on the Graph pull-down menu to modify the title at the top of the 

Chart.    A Dialog Box is displayed when this option is selected, allowing you to modify
the title.



Setting Bar Chart Options
The Options... option on the Bar Graph Graph pull-down menu allows you set certain 

options for the Bar Graph.    When this option is selected, it allows you to set the 
following:

o Select Bar Border Width:    Use this to select a new border thickness for the 
bars in the graph.    The default width for the border    is one pixel; if you desire
a thicker border, you can select the thickness you want from the list box.

o Select Axis Width:    Use this to select a new border thickness for the X and Y
axis.    The default width for the axis    is one pixel; if you desire a thicker line, 
you can select the thickness you want from the list box.

o Tick Mark Value:    You can change the value of the tick mark increment 
which appears on the Y axis.

o Number of Tick Marks:    Define the number of tick marks (and values) 
which appear along the Y axis.    This does not include the tick mark at zero.

When you click the OK button, the changes you have made will be applied to the Bar 
Chart.    If you select the Cancel button, the changes are ignored.



Displaying or Hiding the Legend
By default, the Chart window includes a sub-window containing a legend for the graph.    

This legend indicates the color and pattern associated with each category shown on 
the graph.    You can cause the Legend window to disappear or re-appear by selecting 
the Legend option from the Graph pull-down menu.    The checkmark next to the 
Legend option indicates that the Legend is currently being displayed.



Changing the Category Characteristics
Normally, a default color and hatch pattern is used for each selected category.    This color

and pattern is used to fill in the bars of a Bar Chart or the slices of a Pie Chart.    You 
can select alternate colors and/or patterns by selecting the Category Styles option 
on the Graph pull-down menu.    Each category appearing in the graph is included in 
the sub-menu which is displayed.    By selecting a particular category, you cause a 
Dialog Box to be displayed.    This dialog box contains two selection boxes;    the first 
allows you to choose a new color for the category; the second allows a new pattern to
be selected.

You can also change the category name which appears in the Legend of the chart in the 
Set Graph Category Name field.    Note that if you change a name using this Dialog
Box, you are not permanently altering the name of the original Category; you are 
only changing the name which appears in the chart Legend.    Note also that if you 
change the category name in this manner, you will not be able to zoom in on the Bar 
or Pie slice representing this category.



Advancing to the Next Month
Use the Next Month option of the Calendar pull-down menu to advance the current day

to the first day of the next month.



Setting the Calendar to the Previous Month
Use the Prior Month option of the Calendar pull-down menu to make the first day of the

previous month the current day .



Setting the Calendar to a Specified Date
Use the Go To Date... option of the Calendar pull-down menu to move the current day 

to a specific date that you can enter.    When this option is selected, Home 
Accountant displays the Select New Calendar Date Dialog Box, which allows you to 
enter the date that will become the new current day.    Enter the date in MM/DD/YY 
format, and click on the OK button to specify the new date.    Click the Cancel button 
if you decide not to change the date.



Getting Started
Once you have installed Home Accountant for Windows, you will want to start using it 

to keep track of your household expenses    When you bring up Home Accountant 
for the first time, the screen looks like this:

Windows Interface
Because Home Accountant runs under Microsoft Windows, using it is similar to other 

Windows Applications.    The upper portion of the window contains the main menu, 
and each option on it displays a secondary, pull-down menu when selected.    To 
select a menu item, either click on it with the mouse or hold down the Alt     key 
while you press the underlined character on your keyboard.    The - character in the 
upper left hand corner accesses the System Menu, while the upper right hand corner 
contains the arrow buttons that minimize or maximize the window.    Immediately 
underneath the menu is an area called the 'toolbar'; the buttons in this area 
represent shortcuts to commonly accessed functions within Home Accountant.

Like other types of windows, the Home Accountant window can be re-sized, either with 
the mouse, or by accessing the System Menu.    It can also be minimized and 
maximized using the arrow buttons.

Defining Accounts
The first thing you will probably want to do is to define your Accounts.    Let's say there 

are three accounts you want to define: A checking account at the local bank; a 
Master Card (credit card); and a third account that represents the cash that you carry
around in your purse.    Select the Accounts menu and then select the New option.    A 
Dialog Box is displayed, allowing you to define the first account:



Key in "Checking Account" into the Account Name field, "1000" as the Current 
Balance,and select the OK button.    This defines your checking account, and tells 
Home Accountant that the current balance for the account is $1000.    For each 
account, you must specify the current balance.    

Note that if you currently owe money for your credit 
card, you should specify the amount you owe as a 
negative number.

Entering an Expense Transaction
Now that your accounts have been defined, let's enter a transaction.    Suppose you spend

$20 in cash at the grocery store.    You now need to tell Home Accountant about this
transaction.    To define the transaction, click on the $ button.    This brings up the 
Define Transaction Dialog Box.    The current date and time are already filled in for us,
but you may change them if you like.    By default, the Transaction Type has been set 
to 'Expense'.    You must fill in the Description field (in this case, Groceries), and the To
field (the name of the Grocery store).    Key 20 into the Amount field.    The Select 
Account allows you to specify which account you used to pay the expense; click on 
the Down Arrow and then select the name of your cash account.

Defining a Category
Before completing the transaction, you must categorize it.    Categories are means of 

classifying transactions, and can be anything that's meaningful to you.    For example,
in this case, you might want to define a Category called 'Groceries' which will be used
for keeping track of how much you are spending at the Grocery store.    To define this 
category from the Define Transaction Dialog Box, select the New button next to 
Select Category, and the Define Simple Category Dialog Box appears:



Simple Categories come in two types: expense and income.    We will look at income 
categories a bit later, but for now, we need to define 'Groceries' as an expense 
category.    This is because it is a category that will only be associated with expense 
transactions.    Key the name of the category ('Groceries'), an optional description, 
and, if you wish, a Monthly Budget amount.    You can use this amount in conjunction 
with the Warn if Over Budget option, and it will cause a warning message to appear if
you attempt to spend more per month than you budget.    Click on OK to complete 
the Category definition.

When you return to the Define Transaction Dialog Box, you will notice that the Select 
Category box contains the text 'Groceries'.    This is the category that this expense 
transaction will be associated with when the transaction is recorded.    Click on OK to 
complete the Transaction definition.    If you look at your Cash Account definition, you 
will notice that the current balance is $20 less than the original balance.

Proper definition of categories is key to the use of Home Accountant.    They should be 
defined at the level at which you wish to track your expenses.    Simple categories 
should be defined as specifically as possible; later, you can define something called 
Major Categories.    Major Categories are names given to groups of other categories.    
For example, let's say you have two cars in your family.    You may wish to track 
expenses for these two cars separately, in which case you would define two simple 
expense categories.    You can then define a Major Category called 'Automotive', and 
associate with it the two simple categories.    Now you can track expenses either 
individually by car, or by the Major Category, which represents all automotive 
expenses.    It's also possible to combine simple categories later, but it's difficult, if 
not impossible, to split categories once you have defined many transactions against 
them.

If you go to the grocery store again tomorrow, you will not have to redefine the 
'Groceries' category.    Simply select the category from the Select Category drop-down
list.

Memorizing Transactions



Let's try another transaction.    You put $10 worth of gas in your car, using your Master 
Card to pay for it.    Define the transaction the same way as the first, keying in a 
Description, a To field, and the amount.    Select your Master Card account from the 
Select Account list, and click on New next to Select Category.    Define a new expense
category called 'Automotive'.    Since this is a type of transaction that you will be 
entering a lot in the future, click on the Memorize button.    This causes a prototype 
or model of the transaction to be saved as a 'memorized' transaction, where you can 
recall it in the future with minimal effort.    Memorizing a transaction does not cause it
to be recorded as an actual transaction; to record the transaction and update your 
Master Card account, click OK.

In order to use the memorized transaction next time you buy gas, click on the R button.    
The descriptions of all memorized transactions are displayed.    Select the one you 
want by double-clicking it, and the transaction appears in a Define Transaction Dialog
Box, updated with the current date and time.    You can alter the transaction definition
if you want (for example, changing the amount field), then click OK to record.

Income Transactions
When you receive income, you need to enter an Income Transaction.    For example, let's 

say you deposit your weekly paycheck of $500 into your checking account.    Bring up 
the Define Transaction Dialog Box, but this time, set the Transaction type to Income.   
When you do this, only Income-type categories show up in the Select Category box.    
Since you do not have an Income Categories defined yet, click New to create one.    
Define the category type as Income, and key in the name of the Category (in this 
case, 'My Salary').    Notice that the Monthly Budget field disappears when you define 
the Category as Income.    When you complete the Category definition and click OK, 
the new category name appears in the Select Category box.    Select your Checking 
Account in the left box, as this is where you have deposited the paycheck.    You need 
to fill in the Amount, but the To field is optional.    When you finish defining the 
transaction, the Account field is credited with the paycheck amount.

Transfer Transactions
Suppose you run out of cash, and you make a withdrawal of $50 from your checking 

account at an ATM machine.    This type of transaction is referred to as a Transfer, 
because you are not spending or receiving funds, merely transferring them from one 
account (your Checking Account) to another (your cash account).    When you define 
this transaction, select Transfer as the Transaction type.    You don't need to 
categorize transfers, but you do need to specify the From account (in this case, your 
Checking Account) and the To account (your cash).

Another type of transfer occurs when you pay a credit card bill.    This is not actually an 
expense (the expenses occurred when you used the credit card), but a transfer of 
credit from your Bank account to your credit card account.

Whenever the From account on an Expense or Income transaction is a Bank Account, two 
additional fields appear on the screen: the Check Number field, and the Check 
Reconciled field.    If you have paid for something with a check, you can fill in the 
check number, as this can help you later reconcile the transaction with your bank 
statement.    The Check Reconciled button gets checked later when you actually 
perform reconciliation.

Reports
Now that you have defined a few transactions, you can create a report that lists each of 

them on the screen.    Select the Transactions... option from the Reports pulldown 
menu, and the Define Transaction Dialog Box appears.    Click on the Show Expenses 



radio button, check the Show Detail box, and click the OK button.    Result: a new 
window is created which contains a list of all expense transactions you have defined 
so far.    The transactions are sorted by category, and by date within category.

Place the mouse cursor over one of the description fields (the shape of the cursor should 
change to that of a Magnifying Glass), and click the left button twice rapidly.    After 
the first click, the description field should become darkened (white text on a black 
background).    After the second click, a Define Transaction Dialog Box appears 
containing the details on the selected transaction.    You can change any of the fields 
in the dialog box in order to alter the original transaction definition.

The action you have just performed is called zooming.    Zooming is defined as double-
clicking on any element of a report in order to obtain more details about the element. 
In general, Home Accountant displays the details in a newly created window. 

There are no practical limits on the number of Home Accountant report windows you 
can create and have active concurrently.    You can use the Windows option to display 
the titles of all active windows, and bring a particular window to the top by selecting 
it.

You can delete report windows by selecting the Close option from the system menu, or 
the Exit option from the File menu.    Except for the main Home Accountant window,
report windows are completely independent of each other and can be deleted at any 
time.    If you delete the main window, all other report windows are deleted as well, 
and the Home Accountant program terminates.

If you create a report, and decide that you may need to see the same kind of report again
in the future, you can save the report definition for later use.    Click on the '-' symbol 
in the upper left-hand corner of the report window with the mouse.    A pop-up menu 
will appear.    One of the options in the pop-up menu is Memorize.    If you select this 
option, Home Accountant saves the definition which created the report.    This 
report definition can be later recalled in order to recreate the report.

Budget Files
The information (Accounts, Categories, Transactions) that you define to Home 

Accountant is stored permanently on your Hard Disk in a Budget File.    Before 
exiting Home Accountant, and periodically as you define transactions, you should 
save the Budget File.    Select the Save option from the File pulldown menu to save 
the file.    If this is a new Budget File that you have never saved before, a Dialog Box 
appears which allow you to specify the name of the file, and the sub-directory to 
contain the file.    Select the sub-directory in the right list box, and key in the name 
'BUDGET.BGT' in the area containing '*.BGT'.    This provides a name to the budget 
file.    You can pick any 1 to 8 character name for the file, but the name should be 
followed by '.BGT', which is the convention Home Accountant uses for Budget Files.

As the Budget file is being saved to your disk, the File Save Progress Dialog Box lets 
you know how far along the operation has gone.

The next time you enter Home Accountant, you need to re-load the budget file.    Select 
the Load option from the File pulldown menu to access the File Dialog Box.    Select 
the sub-directory in the right box, and the name of the Budget file in the left box.    
Click on the OK button to reload the file.    After the file is loaded, the Accounts Report
appears in the main window



System Menu Button
Select this button to access the Windows System Menu for the main Home Accountant 

window.



Minimize Button
Select this button to minimize the Home Accountant window and change it into an Icon.



Maximize Button
Select this button to maximize the Home Accountant window so that it fills the entire 

screen.



Menu
This area contains the menu for Home Accountant.    Click on an item in this area to 

access the pulldown menu associated with the item.



Window Caption
This area contains the window title.    The window title will include the budget file name 

once you have saved or loaded a budget file.



Toolbar Area
Each button in this area of the window represents a shortcut to a commonly-accessed 

function within Home Accountant.    For more information, see the topic Using the 
Toolbar.



Window Client Area
This area contains sub-windows containing any reports you create from Home 

Accountant.



Message Area
When you select an option from the Menu or from the toolbar, this area contains a 

message indicating the function of the selected option.



Current Date
This area of the window contains the current date.



Current Time
This area of the window contains the current time.




